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Installation 
 
This Chapter explains how to install the Software and the Hardware Key
Slate Generator.  It also describes the type of system that you will need b
run the program. 
 

System Requirements 
Operating system: 
Slate Generator is designed to run under Windows 98, Windows ME, W
Windows XP.  You need one of these operating systems (or later version
computer in order to run the program. 
 
Processor (CPU): 
Slate Generator will run only on a 500 Mhz Pentium (or higher) processo
 
RAM: 
Slate Generator will run with as little as 16 Mbytes of system RAM.  Ho
very slowly.  It is recommended that you have at least 128 Mbytes of RA
 
Hard Disk Space: 
You must have a minimum of 80 Mbytes of Hard Disk space to run Slate
you intend to create many Background Graphics, or save a lot of slates a
(i.e. BMP, TGA, etc), make sure that you have enough Hard Disk space 
Saving slates in the Cayman Graphics (PAG) format doesn’t require larg
disk space (approx. 2-4 Kbytes per slate) unless logos or textures are add
 
Floppy Disk Drive: 
If you intend to install the software from floppy disks, the system must h
drive capable of reading 1.44 Mbytes floppy disks. 
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Chapter 1 - Installation 

CD-ROM: 
If you intend to install the software from a CD-ROM, the system must have a CD-ROM 
drive. 
 
VGA Card: 
The VGA Card must be set to either 16 bits per pixel (High Color), 24 bits per pixel 
(True Color), or 32 bits per pixel (Alpha) mode.  If you run your VGA card in High 
Color mode, the color spreads may not appear smooth on your VGA monitor.  This will 
not affect the quality of the Title Graphics that the Slate Generator produces.  They 
should appear very smooth in 24 or 32 bits per pixel mode.  The Slate Generator will not 
run if the VGA mode is set to 8 (or less) bits per pixel. 
 
USB Port: 
The computer must have at least 1 unused USB port to install the Hardware Key 
(Dongle). 
 

Installing the Software 
The Slate Generator has a Setup program to help you setup the software to run on your 
computer.  The files on the install disks are compressed.  The only way to make sure that 
the files are uncompressed correctly is to use the Setup program.  The software can be 
installed from either floppy disks, a CD-Rom, or from your hard drive. 
 
Installing from Floppy Disks 
Insert the disk labeled “Slate Generator install disk 1” into the floppy disk drive and 
Run the SETUP.EXE program.  One method of doing this is to press the Start button on 
the Task Bar then Select the Run option.  Enter A:SETUP (or B:SETUP if your floppy 
disk drive is drive B) then press the OK button.  The system will begin installing the 
software. 
 
Follow the instructions on the screen until the software is completely installed.  When the 
software is installed, the computer will restart.  After the computer is restarted the 
Hardware Key (dongle) can be installed. 
 
A folder called “Slate Generator” should now be in the Programs menu.  There will 
also be an Icon called Slate Generator on your desktop. 
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Installing from a CD Rom 
Insert the Slate Generator CD-ROM into the CD-ROM drive.  If the Slate Generator 
Install window does not automatically appear after a few seconds, run the 
“SETUP.EXE” program from the CD-ROM.  The system will begin installing the 
software. 
 
Follow the instructions on the screen until the software is completely installed.  When the 
software is installed, the computer will restart.  After the computer is restarted the 
Hardware Key (dongle) can be installed. 
 
A folder called “Slate Generator” should now be in the Programs menu.  There will 
also be an Icon called Slate Generator on your desktop. 
 
Installing from the Hard Drive 
All of the install files must be in a temporary directory to install the software from the 
hard drive.  This temporary directory SHOULD NOT be named POWERCG.  Run the 
“SETUP.EXE” program from the temporary directory.  The system will begin installing 
the software. 
 
Follow the instructions on the screen until the software is completely installed.  When the 
software is installed, the computer will restart.  After the computer is restarted the 
Hardware Key (dongle) can be installed. 
 
A folder called “Slate Generator” should now be in the Programs menu.  There will 
also be an icon called Slate Generator on your desktop. 
 

Installing the Hardware Key 
Once the software is installed and the computer has restarted, the Hardware Key (dongle) 
can be inserted into one of your computer’s unused USB ports.  A “Found New 
Hardware” window will appear the first time that the dongle is inserted.  Once this 
window goes away Slate Generator is ready to run. 
 
Checking the Installation 
Run the Slate Generator program to test the installation by opening the Slate Generator 
folder and double clicking on the Slate Generator icon, or by double clicking on the 
Slate Generator Icon on the Desktop.  The program’s windows should appear after a few 
seconds.   

3 



Chapter 1 - Installation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left blank 
 

4 



 

 
 
 
 
 
 

Introduction to Slate Generator 

Chapter 

2
 
The Slate Generator is used to create slates.  Of course you knew that or you wouldn't 
have purchased the program.  The best part of Slate Generator is how those slates can be 
used.  You can title over existing graphics or key the slates over an external video source. 
 
You can title over your existing graphics by loading the graphic as a background image 
and adding the title to it.  Once this is done, the titled graphic image can be exported to 
the Clipboard, or it can be saved back to the disk in a standard graphics format. 
 
The slates can contain text (of course), background color boxes, geometric shapes, full-
color graphic images as logos, and either a background graphic or background video. 
 
The text can be created using TrueType typefaces and can be sized, rotated, and 
italicized.  Each character can have up to two edges and three shadows.  The character’s 
edges and shadows can be colorized with either a solid color, a vertical color spread, a 
color gradient (4pt, 5pt, or linear), or with a texture. 
 
Background color boxes can be created any size and position on the screen.  They can be 
colorized with all of the same color options as the characters, they can even be made semi 
transparent. 
 
Geometric shapes can be created at any size and position on the screen.  The roundness 
of the shape can be controlled.  The shape can be made square, completely round (as a 
circle or ellipse), or anywhere in between.  Shapes can be sized, rotated, italicized, edged, 
and colorized just like any other character. 
 
Standard graphic format graphics can be loaded as either full-color logos or as a 
background image.  When graphic images are loaded as logos, they can be sized, edged, 
and positioned anywhere on the screen. 
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Slate Generator User Interface 
If you don't have the software installed yet, follow the directions in chapter 1. 
 
Start the Slate Generator just like you would any other program under Windows.  After a 
few seconds the program’s user interface will appear.  The software automatically adjusts 
its’ windows to fit your screen.  If your screen resolution is set to 1024 by 768, it will 
appear similar to figure 2-1. 
 

 
 

Figure 2-1, Screen appearance on a 1024 by 768 VGA screen. 
 

Menus 
The menu (shown below) is just what you would expect in a Windows program.  It has a 
“File” entry that is used to open, create, and save, the types of files that Slate Generator 
can open, create, and save (slates, templates, and projects).  It has an “Edit” entry that is 
used for the normal Undo, Cut, Copy, Paste, Insert, Delete, and Erase functions. 
 

 
Slate Generator menu. 
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The “View” menu is used to display or hide the various windows. 
 
The “Attributes” menu is used to adjust the various text attributes. 
 
The “Move Text” menu has commands for Word Wrap/Unwrap, Centering, Justifying, 
and Positioning.  It also has a command to let you adjust the Row Leading. 
 
The “Layers” Menu is used to change the layering priority (move one in front of 
another). 
 
The “Settings” menu is used to setup your system.  These include things like Setting User 
Preferences, Loading Typefaces, Setting Tabs, Adjusting Safetitle Margins, set the slate 
to Lower Third mode, and setting your default folders/directories. 
 
The “Text FX” menu launches the Text FX editor.  This allows the Slate Generator to 
independently animate each layer. 
 
The Help Menu is for learning more about how to use the program. 
 

Toolbar 

 
Slate Generator Toolbar 

 
The Toolbar (shown above) is a quick way to access common functions.  These include 
commands from the File menu such as Create New Page, Open Existing Page, and Save 
page.  Check Spelling, cut, copy, paste, and undo functions from the Edit menu are 
included on the toolbar. 
 
The toolbar contains a mode selection box that defaults to "Selected Text".  This 
determines which text will be affected when Character Attributes (font, size, edge, color, 
etc.) are changed or when text is repositioned.  The options include such things are 
Selected text, entire word, entire row, entire layer, and entire page. 
 
To the right of the mode selection box are some buttons that Center and Justify the 
current layer.  There are even buttons to change the priority of the current layer (move 
one in front of another). 
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Project Manager 

 
Project Manager. 

 
The project manager (Shown above) keeps the settings and slates from different projects 
separate from one another.  It also gives you quick access to all of the slates in the 
project.  The top of the Project Manager displays the name of the current project. 
 
When a Slate is saved, a "PICON" is created which is a miniature image of the slate.  
These Picons, along with the name of each slate in the project is displayed in the Project 
Manager.  To open a slate, just click on its PICON. 
 

Slate Compose Window 
The Slate Compose window is where you compose your slates.  To enter text in this 
window, point the mouse to where you want the text to appear, and click the left mouse 
button.  A rectangle will appear where you clicked the mouse.  This is the text cursor.  It 
shows where text will be entered.  Type some text and it will appear at the cursor 
position. 
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Shortcut Buttons 
The Shortcut Buttons window contains buttons of frequently used functions.  They are 
placed in this handy position so that you can just reach over and easily press one of these 
buttons with the mouse. 
 

Preset Style Gallery 
Each project can have up to 64 preset text styles.  These are text styles that you may want 
to use frequently.  You're not limited to only these 64 styles, they are only there as 
shortcut to the styles that you use most often.  You can scroll through the preset text 
styles, and select one by clicking on it.  When you select a new style from the Style 
Gallery, all selected text will be set to the new style.  You can change these preset text 
styles to be whatever you want. 
 

Template Gallery 
Many users like to have a common look to their slates.  Whether it is for their entire 
facility, or a unique "look" for each client.  With Slate Generator you can create a Page 
Template of the desired slate style with "Template Fields" at different positions on the 
slate.  When the Template is opened, a window appears that prompts the user to enter the 
text for each field.  Once the text is entered, the slate is automatically created using the 
style of the Template and the text that was entered in the Template Fields. 
 

Control Tabs 
The Slate Generator gives you a lot of control over the appearance of the characters.  So 
much so, that all of the controls required to set all of the different parameters that can be 
controlled, would not fit on your screen at one time.  So we have divided them up into 
groups and placed each group of controls on its’ own separate tabbed box.  We then took 
each box of controls and placed them all in a single window with tabs to select which 
group of controls that you want to use. 
 
Character Tab 
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The Character Tab is used to change the Height, Width, Italics angle, Rotation, Kerning, 
and Blur of the character.  It is also used to select the Typeface for the text.  Clicking and 
dragging the cursor handles can also change the text size, position, italics angle, and 
rotation.  You can turn the handles on and off.  So they only appear when you want to use 
them.   
 
Any of the values represented by icons (Height, Width, Italics, Rotation, Kerning, and 
Blur) can be modified by clicking on the appropriate icon and dragging the mouse.  The 
text will be redrawn with the new values as you drag the mouse. 
 
Edges Tab 

 
 
Each character can have 2 edges.  You can select from the following:  
 
No Edge 
This edge does not appear 

 
Full Surround 
The edge surrounds the character equally on all sides 
 
Extruded 
The character is extruded to give the character a 3D look 
 
Highlighted 
The character is extruded with a narrow full surround border to highlight the character  
 
Offset 
The edge is offset as if it is casting a shadow.   
 
The depth and blur of each edge can be set separately.  If the selected edge type is 
Extruded, Highlighted, or Offset, the direction can be set to any of the 8 directions.   
 
Both edge work identically.  Edge 1 appears in front of Edge 2.   
 

 10



Chapter 2 – Introduction to Slate Generator 
 
Clicking on the "Depth" icon and dragging the mouse will change the edge depth.  
Clicking on the "Blur" icon and dragging the mouse will change the edge blur.  The text 
will be redrawn with the new values as you drag the mouse.   
 
Shadows Tab 

 
 
Each character can have up to 3 shadows in addition to the 2 edges.  The shape of each 
shadow can be set to be the same shape as the Character, Edge 1, or Edge 2.  All 3 sets of 
shadow controls work the same.   
 
Each component of the character (Character, Edges, and Shadows) stack up in the 
following order:  
 
CHARACTER  
SHADOW 1  
EDGE 1  
SHADOW 2  
EDGE 2  
SHADOW 3  
 
Shadow 1 is between the Character and Edge 1, Shadow 2 is between Edge 1 and Edge 2, 
and Shadow 3 is behind Edge 2.   
 
The position of each shadow can be independently varied in single pixel increments.  
They can be offset from the character by as much as 100 pixels in any direction.  
Clicking on the "Offset" icon and dragging the mouse will move the shadow in 
relationship to the character.   
 
The color of each shadow can be set independently.  It can be set to any color (including 
a Gradient or a Texture) just like the characters and edges. 
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Colors Tab 

 
 
The Colors Tab is used to change the color of the Character, both Edges, and all 3 of the 
Shadows.  On the left there is a group of boxes that display the current color of each 
component of the character.  The box below it shows the color of the component that is 
currently selected.   
 
To change the color, select the component to change (Character, Edge, or Shadow) then 
use the controls on the right to select the color.  There are five ways to select a color.  
You can use a color picker, color sliders, select a color from a preset palette, set the color 
to a gradient, or set the color to a texture.   
 
Press one of the 5 buttons to select which method you want to use to select the color.   
 
There are 5 different methods you can use to select colors, these are: 
 
Color Picker 
Color Sliders 
Color Palette 
Color Gradients 
Textures 
 
Color Picker 
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The color picker lets you select a color using a visual approach.  You can set the top and 
bottom colors separately.  If the top and bottom colors are different, the Character, Edge, 
or Shadow will be drawn with a smooth color spread between the top and bottom.  One 
of the controls in this box is used to select the Hue (red, yellow, green, blue, etc) of the 
color.  When a new hue is selected the other color box will change to reflect the new hue.  
You can select any color from this box just by clicking the mouse on the desired color.   
 
You can also vary the Transparency and the amount of External video levels that the text 
component will be drawn with.  Transparency will let whatever is behind the component 
to show through.  Setting the Video Level draws the component with a mixture of 
background video and a color.  The higher the video level, the more dominant the 
background video will appear.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or 
PAL color.  It will appear green if a legal color is selected.   
 
Color Sliders  

 
 
The color sliders let you select the color using a numerical approach.  You can choose 
whether you want to define RGB (red, green, blue) values or HLS (Hue, Luminance, 
Saturation) values.  The top and bottom colors can be set separately.  If the top and 
bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth 
color spread between them.   
 
You can also vary the Transparency and the amount of External video levels that the text 
component will be drawn with.  Transparency will let whatever is behind the component 
show through.  Setting the Video Level draws the component with a mixture of 
background video and a color.  The higher the video level, the more dominant the 
background video will appear.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or 
PAL color.  It will appear green if a legal color is selected.   
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Color Palette  

 
 
You can select from any of the 64 preset colors from the color Palette.  The top and 
bottom colors can be set separately.  If the top and bottom colors are different, the 
Character, Edge, or Shadow will be drawn with a smooth color spread between them.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or 
PAL color.  It will appear green if a legal color is selected.   
 
You can also select Background Video as the color just by pressing the "Background 
Video" button.  To modify the color palette, double click on the entry that you want to 
modify.  The Color Palette Editor will appear.  This lets you change the color of each 
palette entry.   
 
Color Gradients  

 
 
Each project in the Slate Generator can have as many as 64 preset color gradients 
defined.  They can be either linear gradients or area gradients.  A Linear Gradient can 
have up to 16 color points and can be rotated up to 90 degrees in either direction.  An 
area gradient can set each corner to a different color and the colors will create a smooth 
blend between the colors.  A center color point can also be added to create a 5-point color 
gradient.  The center point can be positioned anywhere within the color gradient.  This is 
very useful for creating Highlighted colors.   
 
You can modify a color gradient by double clicking on the one you want to modify.  The 
Color Gradient Builder will then appear.  The Color Gradient Builder can then be used to 
select the type of gradient, as well as the color and position of the points in the gradient.   
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Color Textures 

 
 
The Textures button lets you apply a texture to any of the text components (Character, 
Edges, or Shadows).  Select any of the loaded textures by clicking the mouse on the 
desired texture.  There can be up to 16 textures loaded for each slate.  GIF, TIF, TGA, 
BMP, PCX, JPG, or JPEG image can be used as textures.  To load a new texture, double 
click on the position that you want to load it into then select the image that you want to 
load as the new texture. 
 
Layers Tab 

 
 
Slate Generator can place text on multiple layers.  Up to 1000 layers can be used on each 
slate.  These layers are completely independent of each other.  Changing something on 
one layer will not affect the text on the other layers.  Each layer can be assigned a unique 
name.  The "Layering Order" list shows the current order of the layers.  The Top layer in 
the list is the front layer of the slate.  A layer is in front of all of the layers that are listed 
below it in the layering list, and behind all of the layers that are listed above it.  Each 
layer can be moved in front of, or behind the other layers.  This is done by using the 
buttons to move the layer to the top layer, Up 1 Layer, Down 1 Layer, or to the bottom 
layer.  The order of the layers can also be changed by dragging it from its current position 
to the new position in the "Layering Order" list.   
 
Individual layers can be hidden so that they do not cover the lower layers that you are 
working on.   
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To create a new layer, press and hold down the <Ctrl> key, then click the left mouse 
button where you want the new layer to appear on the screen.   
 
Positioning Tab 

 
 
The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centering, 
and Justifying rows, entire layers, and entire pages.  The text can also be fine positioned 
by using "Fine Positioning" buttons.   
 
The text can also be positioned by dragging the Cursor Handles with the mouse, or by 
holding down the right mouse button and dragging the selected text to the desired 
position. 
 
Row Spacing Tab 

 
 
These controls are used to change the row leading (spacing) of the cursor row, the entire 
Layer, or the Entire page.   
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Shapes Tab 

 
 
Shapes are boxes that you can control the roundness and aspect ratio of.  Once a shape 
has been placed on the slate you can size it, colorize it, add edges and shadows to it, and 
even rotate it.  In fact you can do anything to a shape that you can do to a character 
(except change its’ typeface of course).  A foreground shape gets inserted into the current 
layer at the cursor position.  A background shape gets added to a new layer that is behind 
the currently selected text. 
 
The aspect ratio of the shape can be changed from tall and skinny to very wide.  The 
roundness of the shape can be set to any value from 0 to 100%.  A roundness of 0% 
creates a shape that has square corners.  A roundness of 100% creates a shape that is 
either a circle or an ellipse (depending on aspect ratio).  A value between 1 and 99% 
creates a box that has rounded corners.  The amount that the corners are rounded is 
determined by the roundness setting.   
 
Logos Tab 

 
 
Full color logos may be added to the slate.  As many as 16 different logos can be added 
to a slate.  The logos can be loaded directly from GIF, TIF, TGA, BMP, PCX, JPG, or 
JPEG images.  If the selected logo image includes an alpha channel, the alpha channel is 
supported. 
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When you Press the "Add New Logo" button, a window appears that allows you to select 
the logo image that you want to place on the slate.  Once a logo is placed you can size 
and edge it just like you would a character.   
 
Background - Image Tab 

 
 
There are two types of backgrounds that can be added to the slates.  A background 
graphic, or background colors.  A GIF, TIF, TGA, BMP, PCX, JPG, or JPEG image can 
be loaded as the background Graphic.  If the background Graphic includes an alpha 
channel, the alpha channel is supported.   
 
A background graphic can be displayed Full screen, Original Size, or Tiled.  When a 
background graphic is loaded as Full screen the graphic is scaled so that it appears full 
screen.  When a background graphic is loaded in its original size, it will not be scaled.  A 
set of buttons will appear to allow you to position the background graphic on the slate.  
Tiling a background graphic that is smaller than the screen will repeat the graphic 
horizontally and vertically to fill up the entire screen.   
 
If you select the "No Graphic" button, no background graphic will appear.  The 
background video will be displayed as the background.   
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Background - Colors Tab 

 
 
Background color boxes can be added to the slate.  You can apply a solid color (with 
transparency and Background video) or you can apply a color gradient (linear, 4 point, or 
5 point).  You can even apply a texture to a background color box.   
 
As many as 32 color boxes can be placed on each slate.  The layering order of 
background color boxes can be changed.   
 
Text Substitution Tab 

 
 
The Text Substitution Tab is used to control the Text Substitution Variables and the 
Template Fields on a slate. 
 
Text Substitution variables are used to display data that may change from time to time.  
These can be things like Temperature, Vote Counts, Sports Scores, or any other data that 
you may want to automatically update.  To enable this feature you must have an optional 
plug in that may be purchased from Cayman Graphics, Third Party Vendors, or you can 
write your own. 
 
Template Fields are used when creating Templates.  This is the text that the user will be 
prompted for when a Template is used to create a Slate. 
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Status Bar 
 

 
The Status Bar (shown above) at the bottom of the screen displays the current status of 
the program.  It is divided into 6 panes.  The first pane displays a one line HINT about 
the Toolbar button or Menu entry that the cursor is currently pointing to.  The next pane 
shows the current Mouse position.  The third pane shows the current Cursor Position.  
The fourth pane shows the name of the current layer.  The fifth pane shows the current 
typing mode (insert or overwrite).  The last pane displays the current row and column 
position of the cursor within the layer 
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Editing Text 
 
The easiest way to learn how to use Slate Generator is to use it.  In thi
create some slates.  They may not always be pretty, but they will demo
the various functions that Slate Generator has to offer. 
 

Create a New Project 
Before we begin creating slates with the Slate Generator, let’s create a
slates.  Selecting the “New Project” command from the “File” menu d
is done a window like the one below will appear. 
 

 
 
Let’s call our project TUTORIAL. Enter the name of the new project 
Project Name” and press the “Create” button.  The name of the new 
appears at the top of the project manager. Since we haven’t created an
project yet, no slates appear in the list.  During this tutorial we will cre
TUTORIAL project. 
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Create New Slate 
Create a new slate by selecting the “New Page” command from the “File” menu. This 
could also be done by pressing the first button on the Toolbar.  If you have modified text 
on the current slate (and “Always Ask First” is selected under “Automatically Save 
Pages” in the “User Preferences”), a window like the one below will appear. 
 

 
 
This reminds you to save any changes to the slate before you create the new slate. Once 
you have selected “Yes” or “No”, a warning message (shown below) will appear warning 
you that the current slate is about to be erased.  
 

 
 
If you press the “No” button the “New Page” command will be canceled.  If you press the 
“Yes” button, a new blank slate will be created. 
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Slate Compose Window 
The Slate Compose window is where you compose your slates. This window displays the 
slate that you are working on as you compose it.  If this window is smaller than the actual 
slate that you are creating, the image will be scaled to fit this window.  If the image is too 
small to see, try one of the following: 
 
Maximize the Slate Generator window. 
 
Use a higher resolution VGA mode (i.e. 1024 by 768). 
 
Use the View menu to turn off other Slate Generator windows to make more room for the 
Slate Compose Window. 
 
Select the View Title Full Size command from the View menu to make the slate compose 
window full size. 
 

Typing Text 
To enter text in this window, point the mouse to where you want the text to appear, and 
press the left button. A rectangle appears where you clicked the mouse. This is the text 
cursor. It shows where text will be entered.  Now type the message “I Really like the 
Slate Generator”, the text will appear on the VGA screen as you type it. If you are 
running on a system that has a separate video output, you will notice that the text also 
appears on that screen. 
 
If the text is too big to fit on the screen, select a smaller text style from the Style Gallery 
(on the right side of the screen) and throw away the slate with the big characters by 
creating a new slate again. Then re-type the message “I Really like the Slate 
Generator” with the smaller text style. 
 

Moving the Cursor 
You can use the cursor movement keys to move the cursor around in this window, or you 
can use the mouse to point to where you want the cursor to be placed and click the left 
button. The Arrow keys move the cursor one character or row in the direction of the 
arrow. The <Home> key moves the cursor to the beginning of the row if it’s not already 
there. If the cursor is at the beginning of the row and you press the <Home> key, it will 
move to the beginning of the layer.   If the cursor is already at the first character of the 
layer, the <Home> key will move the cursor to the beginning of the “Main” layer.  The 
<End> key moves the cursor to the end of the row if it’s not already there. If the cursor is 
already at the end of the row, it will move to the end of the layer.  If the cursor is already 
at the end of the layer, the <End> key will move the cursor to the end of the “Main” 
layer. 
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Editing Text 
Move the mouse over the “R” in “Really” and press down the left button on the mouse. 
While holding down the Left button, drag the mouse to the “i” in “Like” and release the 
mouse button. Notice how the cursor expands to cover the text “Really Li”.  This is the 
text that is now selected. Any operations done to the text will be done to the text that is 
selected. Press the <Del> key. The text that was selected was deleted.  To get this text 
back, hold down the <Ctrl> key and press the <Z> key (you could also press the UNDO 
button in the toolbar).  The last operation (delete in this case) is undone. The Slate 
Generator will let you UNDO as many as 1000 operations. 
 
Move the cursor to the “P” in the word “Power”. Hold down the <Shift> key and press 
the <Enter> key. This splits the row into two rows. A new row is created under the 
current row and the character that the cursor is on, and all characters after it, are moved 
down to the new row. 
 
Press the <Enter> key to move the cursor to the beginning of the next row. Hold down 
the <Shift> key and press the <Ins> key. This inserts a new row at the cursor position. 
Now type “Cayman Graphics”.  Let’s delete this new row. We could use the UNDO 
function, but let’s use the delete row function instead.  Hold down the <Shift> key and 
press the <Del> key. The cursor row is deleted and all rows underneath it move up to 
take its place. 
 
Move the cursor to the “R” in “Really”. Delete this word by holding down the <Ctrl> key 
while pressing <Del>.   The entire word is deleted and all text to the right of it moves 
over to fill in the space. Move the cursor to the “i” in “like”. Type the letters “ove”. The 
new letters replace (overwrites) the text already on the screen.  The typing mode can be 
changed to “Insert” (see the “Insert Mode” command in the “Settings” menu).  
 
Move the cursor to the beginning of the second word on the top row. Insert five (5) 
spaces by holding down the <Alt> and pressing the <Ins> key 5 times. Now type the 
characters “Just”. This enters a new word in the space that you just inserted (4 characters 
for the word, 1 character for the space).  
 
The functions that you just learned (as well as others) can also be invoked by using the 
commands in the “Edit” menu. This menu also shows the keyboard short cut keys for 
these commands in case you forget them. 
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Saving the Slate 
Before we go through the “Erase Text” functions, let’s save the slate so we can use it 
later.  Select the “Save Page” command from the “File” menu, or press the Third button 
(with the floppy disk icon) in the Toolbar.  Since this slate has not yet been named, you 
will be prompted to enter a name for it.  Once the name has been entered (Let’s call it 
FIRST) press the “Save” button and the slate will be saved to the current project.  Notice 
that a small “PICON” of the slate appears in the Project Manager window along with the 
name of the slate. 
 

Erasing Text 
The “Edit” menu has commands for erasing text. You can erase text from the cursor 
position to the end of the row, from the cursor position to the end of the slate, or all of the 
text on the slate. 
 
Move the cursor to the “V” on the first row, then go to the “Erase Text” entry in the 
“Edit” menu and select “to End of Row” command.  Notice that all of the text from the 
cursor position to the end of the row is erased. 
 
Select the “to End of Page” command and all of the text from the cursor position to the 
end of the slate is erased. Select the “Entire Page” command, and all of the text on the 
slate is erased. 
 

Backspace 
If you make a mistake while typing (such as typing the wrong character) just press the 
<Backspace> key.  This will move the cursor to the previous position and erase the 
character there.  If the system is in Insert mode, the character will be deleted.  You can 
then type the correct character. 
 

Using Tabs 
The Slate Generator allows you to set up to 16 tabs per slate.  These tabs specify 
horizontal positions on the screen. Columnar text can be aligned to the tabs.  If the Tab 
Display is enabled, the tab positions appear as vertical lines the entire height of the 
screen.   
 
The tabs behave differently depending on the typing mode.  In the Insert mode, pressing 
the <Tab> key will insert a tab character at the cursor position.  All text to the right of the 
new tab will be moved to the next tab position.  Pressing the <Tab> key in the Overwrite 
typing mode will move the cursor to the character at the next tab position.  If no tab is set 
to the right of the cursor, the cursor will move to the beginning of the next row. 
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The width of the Tab character is automatically adjusted so that the next character is 
placed at the next tab position.  If no tab is set to the right of the tab character, it is treated 
the same as a space.  Changing the text to the left of the tab character (by entering more 
text or changing the size of the text) will not move the text that you have placed at the 
next tab position unless the text becomes too big to fit in the allotted space. 
 
Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).  
Any text that is entered before the tab will be inserted at the cursor position and the width 
of the tab will be adjusted to keep the text at the next tab position from moving.  To get 
rid of a Tab character, use the <Backspace> or <Del> key. 
 
The tab positions are stored with the slate.  When a slate is recalled from the disk, the tab 
positions that the slate was created with are loaded with it. 
 
For more information on default set tabs, setting tabs, deleting tabs, and tab display see 
the section titled “Setting Up Tabs” in chapter 14. 
 

Row Space Allocation 
As text is entered, sized, and repositioned, rows of text may begin to overlap each other, 
or may appear with too much spacing between them.  To set the Row spacing back to 
what it should be (based on the text on the row), press the “Reset Row Spacing” button in 
the shortcuts window to reset the height of every row of the slate. 
 

Cursor Movements 
The cursor movement keys allow you to move the cursor around the screen. The cursor 
can also be positioned with the mouse. 
 
Cursor Up 
The <↑> key moves the cursor up one row unless it is already on the top row of the slate.   
 
Cursor Down 
The <↓> key moves the cursor down one row.  
 
Cursor Left 
The <←> key moves the cursor left one character position.  If the cursor is at the left 
margin, the cursor will move to the end of the next row up (provided it’s not already on 
the top row). 
 
Cursor Right 
The <→> key moves the cursor right one character position.  If this moves the cursor 
beyond the end of the row, the cursor will move to the beginning of the next. 
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Home 
Press the <Home> key to move the cursor to the first character of the row.  If the cursor 
is already on the first character of the row, pressing the <Home> key will move the 
cursor to the first character position of the first row of the layer. 
 
End 
Press the <End> key to move the cursor to the last character of the row.  If the cursor is 
already on the last character of the row, Pressing the <End> key will move the cursor to 
the last character of the layer. 
 
Page Up 
Pressing the <Page Up> key will move the cursor to the last character on the 
 
Page Down 
Pressing the <Page Down> key will move the cursor to the home position. 
 
Setting Cursor Position with the Mouse 
The cursor can be moved with the mouse.  Move the mouse pointer to the desired 
position and click the left button.  The cursor will move to the character being pointed to.  
If characters are overlapped, continue to click the left button until the desired character is 
selected 
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Text Styles 
 
One of the most amazing things about Slate Generator is the amount of control you have 
over the text style.  Each character is made up of six different components.  These are the 
character, two edges, and three shadows. 
 
Each of these six character components can be set to either a solid color, a vertical color 
spread from the top to the bottom of the character, a color gradient that you can define, or 
a texture. 
 
You can select a TrueType Typeface for the character and control the Height, Width, 
Italics Angle, Rotation, Kerning, and the Blur of the character. 
 
For each edge you can select the Edge Type, Direction, Depth, and the Blur.  For any of 
the three shadows you can select the shape (to be the same as the Character, Edge 1, or 
Edge 2) and the offset from the character.  The shadow can be offset from a character by 
as much as 100 pixels horizontally and vertically. 
 
Many of the text style attributes (height and width for example) are represented 
numerically.  These numerical attributes can be modified by controls that are either 
absolute or relative.  An absolute control will set all of the selected text to the new value.  
A relative control will change all of the selected text by the same amount. 
 
To illustrate the difference between absolute and relative, let's assume there is a word on 
the screen.  The size of the first character of the word is 50 scan lines; the rest of the 
word is 25 scan lines high.  If you select the entire word and use a relative control to 
increase the height of the first character by 25 scan lines from (50 to 75 scan lines), the 
height of the rest of the word will be increased by 25 scan lines to 50 scan lines. 
 
If you use an absolute control to set the height of the first character to 60 scan lines, the 
height of the entire word will be set to 60 scan lines (they won't maintain their height 
relative to each other). 
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Character Styles 
To change the character style, select the Character Tab in the Control Tab Window.  The 
controls for adjusting the character style will be displayed as shown below. 
 

 
 
This control tab window has 6 groups of controls to control numerical character 
attributes.  It also has a Cursor Handle Button, a Typeface selection box, and a button 
that you can press when you want to load new Typefaces. 
 
The numerical control groups are: 
 
Height 
Width 
Italics 
Rotation 
Kerning 
Blur 
 
Each group of numerical controls is made up of 4 controls.  The top control in the group 
(the one with the icon) is a drag button.  The drag button is the relative control of the 
group.  To use the drag button, move the mouse over it, press the left mouse button, and 
drag the mouse.  Moving the mouse up or to the right will increase the value.  Moving the 
mouse down or to the left will decrease the value.  The other three controls in the group 
are the absolute controls. 
 
The absolute controls consist of a number box and two small buttons to the right of it for 
increasing and decreasing the value.  The value in the number box can be entered directly 
by moving the mouse over the number, double clicking the mouse (this will highlight all 
of the digits in the number), and entering the new value.  Pressing the increase button to 
the right of the value can increase the value.  If you hold this button down the value will 
continue to increase until you release the button.  To decrease the value, press the 
decrease button.  Holding down this button will continue to decrease the value until you 
release it. 
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If you move the mouse over the number, then press and hold down the left mouse button, 
you can change the value by moving the mouse.  Moving the mouse up or to the right 
will increase value.  Moving the mouse down or to the left will decrease the value.  When 
you have the desired value, release the left mouse button. 
 
The Cursor Handle Button performs two functions.  It allows you to turn the cursor 
handles on and off.  It’s also there as a reminder as to what each cursor handle is used 
for. 
 
The Typeface selection box lets you select a different Typeface and there is an "Add New 
Typefaces" button that you can press when none of the 25 typefaces that are currently 
loaded are what you want. 
 
Let's explore these buttons a little closer.  Create a new slate by pressing the New Page 
icon in the toolbar.  From the style gallery select a reasonably sized text style.  Then type 
the word TEST in all capital letters.  Press the home key to move the cursor to the first 
“T” in the word “TEST”. 
 
Move the cursor over to the Height Drag Button, press and hold down the left mouse 
button and move the mouse up.  Notice that the size of the character increases.  Release 
the left mouse button. 
 
Drag the cursor across the entire word to select it.  Move the mouse over the Height Drag 
Button, press and hold down the left mouse button, and move the mouse down.  Notice 
that the height of every character in the word decreases by the same amount.  The value 
of the number box is changed to display the current height of the first character that is 
selected.   
 
Now let's see how the absolute controls behave differently.  Move the mouse to the 
height number box and double-click it.  This will highlight all of the digits.  Re-enter the 
digits exactly as they were before (if they were originally 48, enter 48) and press the 
<Enter> key.  Notice that all of the characters became the same size as the first 
character; they did not maintain their relative character heights. 
 
The height of the characters can be varied and set to any size between 600 scan lines high 
and negative 600 scan lines high.  The negative character height will draw the characters 
inverted (upside down).  Try experimenting with the height controls to see how they 
affect the characters. 
 
Changing the width of the characters will make them appear thinner or wider.  The width 
can be varied anywhere between 10 percent of normal (very thin) to 500 percent of 
normal (five times their normal width).  A width of 100% is the normal width for the 
character.  Try experimenting with the width controls to see how they affect the 
characters. 
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The italics angle of the text can be varied up to 45 degrees in either direction.  A negative 
italics angle will slant the characters to left, the positive italics angle will slant the 
characters to the right.  Try experimenting with the italics controls to see how they affect 
the characters. 
 
Each individual character, or group of characters, can be rotated up to 360 degrees in 
either direction.  A positive value will rotate the text clockwise, while a negative value 
will rotate the text counter clockwise. 
 
The kerning controls allow you to change the spacing between the characters.  A negative 
value will move the characters closer together.  A positive value will move the characters 
further apart. 
 
The amount of blur on the characters can be changed using the blur controls.  A blur 
value of 2 gives you a crisp sharp character; a blur value of 12 gives you a very fuzzy 
character.  The blur of the character and the blur on each of the two edges can be set 
independently of each other.   
 
Cursor Handles 
Cursor Handles are points on the cursor that allow you to click and drag the text around 
the screen.  With these handles you can move, size, rotate, and italicize the text.  The 
Cursor Handle Button (on the right hand side of the character tab window) is used to turn 
the Cursor Handles on and off.  It also has a little diagram that shows what each handle is 
used for.   
 
Turn the cursor handles on by pressing the Cursor Handle Button.  Notice that eight small 
boxes appear around cursor.  Each of these small boxes is a handle.  You can move the 
selected text by clicking on the handle in the lower left corner and dragging the mouse.  
Each time you pause the mouse, the text will be redrawn at the new position.  If you only 
want to move the text horizontally (without affecting the baseline alignment) you can use 
the handle on the left side of the cursor.  If you accidentally move the mouse vertically 
while dragging this handle, the text will not move vertically.  Using the handle on the 
bottom of the cursor will only move the text vertically; it will not allow it to move 
horizontally. 
 
Use the handle at the top of the cursor to adjust the height of the characters.  When you 
change the size of the cursor by dragging this handle, the height of the text will be 
changed to match the cursor size.  The relative size of each selected character will be 
maintained. 
 
Use the handle on the right side of the cursor to adjust the width of the text.  Dragging 
this handle left or right will change the relative width of each selected characters.  When 
you change the width of the cursor by dragging this handle, the relative width will be 
adjusted to fit within the new cursor size. 
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Dragging the handle on the upper right corner of the cursor will adjust both the height 
and width of the text.  Dragging the handle on the lower right corner of the cursor will 
rotate the selected text.  Dragging the handle on the upper left corner of the cursor will 
change the italics angle of the text. 
 
When you are through using the cursor handles, and you no longer want them to be 
displayed, press the Cursor Handle Button again to turn the handles off. 
 
Typefaces 
The typeface selection box shows the current typeface.  If you open this box up by 
pressing the down arrow on the right hand side, all of the typefaces that are currently 
loaded will appear.  Click on any typeface in this list to select it.  When a new typeface is 
selected, the selected text will be redrawn with the new typeface. 
 
Loading New Typefaces 
Slate Generator can load two types of typefaces, Cayman Graphics format or TrueType 
format.  The Cayman Graphics format is a proprietary format.  The typefaces that came 
with the program are in this format.  The TrueType format is the most popular format 
and has the widest selection of typefaces.  You can load up to 25 typefaces for each 
project.  When you use typefaces on a slate, the system keeps track of which typefaces 
are needed to display the slate.  If the loaded typefaces do not match the typefaces needed 
by the slate, the correct typefaces are automatically loaded. 
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To load new typefaces press the "Add New Typefaces" button.  When this is done the 
Load New Typefaces window will appear as shown below. 
 

 
Load New Typefaces dialog box 

 
The typefaces that are currently loaded are listed on the right hand side of this window.  
The typefaces that are available to be loaded (in the current directory) are listed on the 
left hand side.  The current directory is displayed in the center. 
 
Select the typeface format (TrueType or Cayman Graphics) that you want to load.  All of 
the typefaces in the current directory of the selected format will appear on the left side 
under “Available Typefaces”.  If the typefaces are TrueType, the full name of the 
typeface is shown in the actual typeface (for example, the name Helvetica will appear in 
the Helvetica typeface, the name Times New Roman will appear in the Times New 
Roman typeface).  You can use this feature to preview the typefaces without the need to 
load them first.  To get a better look at a typeface, click on it in this list.  A larger sample 
of this typeface will appear. 
 
If the desired typeface is not in the current directory, select the proper directory.  Your 
system typefaces are usually stored in the "C:\WINNT\FONTS" or the 
"C:\WINDOWS\FONTS" directory\folder. 
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The typefaces do not need to be installed on your system.  You can load typefaces 
directly from a CD-Rom.  When you load a TrueType typeface, a copy of it is made on 
your hard drive (in the POWERCG\TYPEFACE folder).  You can then remove the CD-
Rom and the program will still be able to find the typefaces when it needs them. 
 
To load a new typeface, select the position that you want to load it into in the “Loaded 
Typefaces” list, select the typeface to load in that position from the “Available 
Typefaces” list, then press the load button.  The new typeface will appear in the “Loaded 
Typefaces” list and the next position in the “Loaded Typefaces” list will be selected.  The 
typeface may also be loaded by double-clicking on it in the “Available Typefaces” list.   
 
When you have finished loading typefaces press the “Done” button and the Load New 
Typefaces window will disappear.  Notice that the new typefaces now appear in the 
Typeface Selection Box. 
 
Scope Selection  
Now that we have the basics of character attributes down, let's try something a little more 
advanced.  Create a new slate.  Set the character Height to 24 scan lines, the Width to 100 
percent, Italics to 0 degrees, and Rotation to 0 degrees.  Set the Kerning to 0 and the 
Character Blur to 2.  Selected a clean/easy to read typeface such as Boston Black, 
Futurist, or Bassett Bold.  Now type the following three lines of text: 
 
The quick Brown Fox 
jumped over the 
lazy dogs back. 
 
Place the cursor on the M in the word “jumped” and select a different typeface.  Notice 
that only the character under the cursor changed.  If the toolbar is visible (above the slate 
compose window) you'll see a selection box with the words "Selected Text".  This is 
called the “Scope Selection Box.” This selection box is used to determine how much text 
the Text Style changes will affect.  If the toolbar is not visible, display it by selecting the 
“Display Toolbar” command from the “View” menu.  Open this box by pressing the 
down arrow and the following options will appear: 
 
Selected Text 
to End of Word 
Entire Word 
to End of Row 
Entire Row 
to End of Layer 
Entire Layer 
Entire Page 
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Change this selection to “to End of Word”, then change the rotation angle to minus 10 
degrees.  Notice that every character from the M to the end of the word is rotated.  Go 
back to the toolbar and change the selection to “Entire Word”.  Increase the height to 48 
scan lines.  Notice that the height of the entire word changed.  Now select the “to End of 
Row” entry from the scope selection box and set the width to 50 percent.  Notice that all 
text from the cursor position (the M in jump) to the end of the row changed its width. 
 
Set scope to “Entire Row” and select a new typeface.  Every character on the row is now 
drawn with the new typeface.  Select “to End of Layer” from the scope selection box and 
set the height to 60 scan lines.  Every character from the cursor position to the end of the 
row, and every character on every row after the cursor changed to the new height.  Now 
select “Entire Layer” as the scope and select a new typeface.  Notice that every character 
on the slate changed to the new typeface.  There is one more entry in the scope selection 
box that we have not discussed yet.  It is “Entire Page”.  Selecting this entry would 
change all of the text on all of the layers if we had multiple layers on the slate.  You'll 
find out more about this when we discuss Layers in Chapter 6. 
 
When “Selected Text” is chosen, the changes are applied to the character or group of 
characters that are selected by the cursor.  To select multiple characters, move the mouse 
to the first character to select, hold down the left mouse button, and drag the mouse to the 
last character to select.  Dragging the mouse will not select text that is on more than one 
row unless the <Shift> key is held down while the mouse is being dragged. 
 
Row Spacing (Leading) 
When we increased the size of the text, the rows of text overlapped each other.  
Sometimes we want this effect, other times we don't.  If you want to adjust the row 
spacing to match the text, press the “Reset Row Spacing” button in the “Shortcut 
buttons” window (to the right of the slate compose window).  This will adjust the row 
spacing (leading) so that the rows don't overlap. 
 
With “Entire Layer” still selected as the scope, set the Height to 24 scan lines and the 
Rotation angle to 0 degrees.  Now there is too much space between the rows.  Press the 
“Reset Row Spacing” button again and the excess row spacing (leading) will be removed. 
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Edges 
To change the Edge Styles, select the Edges Tab in the Control Tab Window.  The 
controls for changing the edges will be displayed as shown below. 
 

 
 
This control tab window has 2 complete sets of controls for controlling both edges.  The 
controls on the left are used to set Edge 1; the controls on the right are used to set Edge 2.  
Since both sets of controls are identical, we will discuss both of them at the same time. 
 
Each set of edge controls are made up of four groups of controls.  One group selects the 
Edge Type, another group selects the Direction of the edge, and there are two groups 
used to control the numerical values Edge Depth and Edge Blur. 
 
Edge Type 
The Edge Type is controlled by a group of five buttons.  These buttons are called radio 
buttons because only one button can be selected at the time (just like buttons on the car 
radio).  Pressing one button will deselect the others.  These buttons are used to select the 
edge type and to indicate the current edge type.  The edge types that can be selected are 
as follows: 
 
No Edge 

 
Shows just the characters without any 
edge. 

 
Full Surround Border  

 
Displays the characters with a border around them.  The border has equal depth on 
all sides of the character.  The depth of the border is set by the Depth controls. 

 
Extruded Shadow 
 

 

Extruded Shadows appear connected to the character.  This gives the characters 
sort of a three-dimensional look.  The direction of the shadow is determined by 
the Direction controls, and the depth is set by the Depth controls.  
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Highlighted Shadow 
 

 

A Highlighted Shadow is very similar to an extruded shadow.  However a fine 
border appears to highlight the character.  The direction of the shadow is 
determined by the Direction controls, and the depth of the shadow is set by the 
Depth controls. 

 
Offset Shadow 
 

 

An Offset Shadow is separated from the character.  This makes it appear as 
though the character is above the background and is casting a shadow on it.  The 
direction of the shadow is determined by the Direction controls, any offset of the 
shadow is set by the Depth controls. 

 
Pressing the appropriate button selects the edge type. The button then appears depressed 
to indicate the current edge type. 
 
Edge Direction 
The direction of the extruded shadow, highlight shadow, and offset shadows can be 
controlled.  The direction control group (shown below) controls the direction. 
 

 
 
There are eight buttons around the outside of this group.  Each button represents one of 
the eight possible directions (Upper Left, Up, Upper Right, Right, Lower Right, Down, 
Lower Left, and Left).  Pressing one of these buttons will select the corresponding 
Shadow Direction.  When the direction is selected, the button appears depressed to 
indicate the current direction. 
 
There is also a button/indicator in the middle of the Direction Selection Buttons.  This 
also indicates the current shadow direction.  Pressing this button will advance the shadow 
direction clockwise to the next direction. 
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Edge Depth 
The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels.  
An edge depth of zero will not be seen unless you make the edge blurrier than the 
character.  Setting the edge depth to 99 scan lines will make an extremely deep edge that 
may slow down the drawing of the characters.  If you want a really deep edge like this, 
and you have a slower CPU, I suggest that you compose the slate using a smaller edge 
first.  This lets you compose the slate without being slowed down too much.  After the 
text is typed, you can make the edges as deep as you want.  The edge depth will not have 
any effect on the edge if the Edge Type is No Edge. 
 
The numerical controls in this group have both Relative and Absolute controls.  They 
work just like the numerical controls on the Character Tab. 
 
Edge Blur 
The amount of blur on the edges can be changed by the controls in this numerical control 
group.  A Blur setting of 2 gives a crisp sharp edge; a blur setting of 12 gives you a fuzzy 
edge.  The Blur of each edge and the character can be set independently of each other. 
 

Shadows 
The Slate Generator can display each character with 3 independent shadows.  These are 
called Shadow 1, Shadow 2, and Shadow 3.  Shadow 1 is drawn behind the character and 
in front of Edge 1.  Shadow 2 is drawn between Edge 1 and Edge 2.  Shadow 3 is drawn 
behind Edge 2.  You can control the shape and offset (horizontal and vertical) of each 
shadow independently.   
 
To change the Shadow Styles, select the Shadows Tab in the Control Tab Window.  The 
controls for changing the shadows will be displayed as shown below. 
 

 
 
This control tab window has 3 complete sets of controls for controlling all three shadows.  
The controls on the left are used for Shadow 1, the controls in the middle are used for 
Shadow 2, and the controls on the right are used for Shadow 3.  Since all three sets of 
controls are identical, we will discuss all three of them at the same time. 

 39  



Chapter 4 - Text Styles 

Each set of shadow controls are made up of 2 groups of controls.  One group selects the 
Shape of the shadow; the other group selects the shadows’ offset. 
 
To help demonstrate the Shadows, we should make both of the edges look significantly 
different from the character as well as each other.  Select the “Character” Tab.  Set the 
Height to 48 scan lines, the Width to 100%, the Italics and Rotation angles to 0 degrees, 
and the Blur setting to 2.  Now select the “Edges” Tab.  Set the Edge 1 type to “Full 
Surround”, set its’ Depth to 8 pixels, and set its Blur to 7.  Set the Edge 2 type to 
“Extruded Shadow”, set it’s direction to “Lower Right” set its’ Depth to 30 pixels, and 
its’ Blur to 12. 
 
We also need to set the character, edge, and shadow colors so we can easily tell them 
apart.  Warning - this could end up looking ugly.  Select the “Colors” Tab; this will 
display the color controls.  Press the “Palette” button to display the preset color palette. 
 
Press the “Character” button in the “Component” control group to tell the system that we 
want to change the Character color (make sure both the “Top Color” and “Bottom Color” 
check boxes are marked).  Scroll down in the color palette until the “White” entry 
appears and select it as the character color.  Press the “Edge 1” button, make sure both 
the “Top Color” and “Bottom Color” check boxes are marked, and select a “Reddish” 
color for it from the color palette.  Press the “Edge 2” button, make sure both the “Top 
Color” and “Bottom Color” check boxes are marked and select a “Greenish” color for it 
from the color palette. 
 
Let’s set the Shadow colors now.  Press the “Shadow 1” button; make sure that both the 
“Top Color” and “Bottom Color” check boxes are marked, and select a “Blue” color for 
it.  Press the “Shadow 2” button; make sure that both the “Top Color” and “Bottom 
Color” check boxes are marked, and select a “Magenta” color for it.  Press the “Shadow 
3” button, make sure that both the “Top Color” and “Bottom Color” check boxes are 
marked, and select a “Yellow” color for it.  Now we can definitely tell which component 
(Character, Edge, and Shadow) is which. 
 
Select the “Shadows” tab to display the “Shadows Control Window”.  Type the word 
“SHADOWS” on the screen then drag the mouse over the word to select the entire word. 
 
Select “None” as the shape of all three shadows.  Use the “Offset” controls for each 
shadows to set the offsets of each shadow to the following: 
 
 Vertical Offset Horizontal Offset 
Shadow 1    8    9 
Shadow 2 -26 -27 
Shadow 3 -40  30 
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Shadow Shape 
The Shadow Shape control group is made up of 4 buttons (to select the shape of the 
shadow)  and an indicator (to indicate the current shadow shape). 
 
A shadow can be set to be the same shape as the Character, Edge 1, Edge 2, or it can be 
turned off.  To turn the shadow off, press the “None” button.  To make the shadow the 
same shape as the character, press the “Character” button.  To make the shadow the same 
shape as edge 1, press the “Edge 1” button.  And so on. 
 
As each shape is selected, the Current Shadow Shape Indicator (below the shape 
selection buttons) will change to indicate the current shadow shape.  You can also click 
on the Current Shadow Shape Indicator to advance the shape of the shadow to the next 
shape. 
 
Select the different shapes for Shadow 1.  Notice that when you select the shape for the 
shadow, it appears as blue (earlier, we selected blue as the shadow one color) behind the 
Character and in front of Edge 1 (the red edge).  Do the same for Shadow 2 and Shadow 
3.  Notice that Shadow 2 (magenta) is drawn behind Edge 1 (the red edge) and in front of 
Edge 2 (the green edge).  Shadow 3 (yellow) is drawn behind Edge 2. 
 
Set the shape of Shadow 1 to “Character”, the shape of Shadow 2 to “Edge 1”, and the 
shape of Shadow 3 to “Edge 2”. 
 
Shadow Offset 
The shadows can be offset from the character in any direction in single pixel increments.  
The shadows can be offset horizontally from the character by as much as 100 pixels in 
either direction.  A negative value offsets the shadow to the left.  A positive value offsets 
the shadow to the right.  The shadows can be offset vertically from the character by as 
much as 100 scan lines.  A positive value places the shadow above the character; a 
negative value places the shadow below the character 
 
The shadow offset controls for each shadow work very similar to the numerical controls 
in the “Character” and “Edges” tabs.  The offset drag button (shown below) can be used 
to control both the vertical and horizontal offsets. 
 

 
 
Dragging the mouse left or right will adjust the horizontal offset.  Dragging the mouse up 
or down will adjust the vertical offset. 
 
Click on the "H" in shadows to select it.  Click on the Shadow 1 Vertical Offset Number 
Box and drag the mouse down.  The blue shadow (Shadow 1) moves down when you 
move the mouse.  Click on the Shadow 1 Horizontal Offset Number Box and drag the 
mouse to the right.  Shadow one moves to the right when you move the mouse. 
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Notice that Shadow 1 on the “H” character is in a different position than Shadow 1 on the 
other characters.  Drag the mouse across the entire word to select all the characters.  
Position the mouse over the Shadow 1 Offset Drag Button and press the left mouse 
button.  Now move the mouse around while holding down left button.  Notice that 
shadow 1 on all of the characters moves with the mouse, and that Shadow 1 on the “H” 
maintains its position relative to the rest of the characters. 
 
Try experimenting with the offsets for Shadow 2, and Shadow 3.  You'll see that they 
work exactly the same way as Shadow 1. 
 
Save this slate with the name “SHADOWS”. 
 

Text Colors 
Select the “Colors” Tab in the Control Tab Window to adjust the Text Colors.  This will 
display the Colors Control Window (shown below). 
 

 
 
The Colors Control Window has three main sections.  The first section (on the left) is 
used to select which component of the text (character, shadow 1,edge 1,shadow 2, edge 2, 
or shadow 3) to change the color of.  The next section is a group of buttons used to select 
the method of choosing a color (color picker, color sliders, color palette, color gradient, 
or textures).  The last section has the controls used in choosing a color.  These controls 
change based on the method of choosing a color that you have selected.   
 
Text Components 
The component group of controls contains six buttons for selecting which component of 
the text to change the color of, (character, edges, or shadows).  To change the character 
color, press the “Character” button.  To change the color of edge 1, press the “Edge 1” 
button.  And so on.  When a new text component is selected, the color indicator box in 
the lower left corner of this group is changed to display the current color.  The color 
indicator box displays the current color as it is being modified. 
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The component section of the Colors Control Window has an indicator to show the 
current color of each text component.  These boxes display the text components in the 
same order that they will appear on the screen.  The front box of this indicator shows the 
current Character color.  The box behind it (that is offset down and to the right of it) 
shows the current Shadow 1 color.  The box that is behind to both the Character and 
Shadow 1 indicators, displays the current Edge 1 color.  The box behind and offset down 
to the right of the Edge 1 indicator, displays the current Shadow 2 color.  The box that is 
behind both the Edge 1 and Shadow 2 indicators, displays the current Edge 2 color.  The 
box behind all of the others is the Shadow 3 color indicator. 
 
If you click on any of these indicators, the component that it represents will be selected.  
The appropriate component selection button will appear depressed to indicate the current 
component.  The color indicator box will also be changed to the color of the selected 
component. 
 
Color selection methods 
There are five different methods of selecting a color.  These methods are as follows: 
 
Color Picker 
The Color Picker lets you select the color using a visual approach 
 
Color Sliders 
The Color Sliders lets you select the color using a numerical approach. 
 
Color Palette 
The Color Palette lets you select a color from a palette of 64 preset colors. 
 
Color Gradient 
A color can be selected from a group of 64 user defined color gradients.  This may be 
either a linear gradient with up to 16 color points that can be rotated up to 90 degrees in 
either direction.  It can also be an area gradient that can have four or five color points 
defined. 
 
Color Texture 
A Color Texture can be selected from any of the 16 textures that are currently loaded. 
 
Before we begin experimenting with changing colors of the text, we should have some 
text that uses both of the edges and all three of the shadows.  Let's open the “Shadows” 
slate (if it isn't already open) that we created earlier.  Drag mouse across the entire word 
to select all of the characters.  We are now ready to play with the colors. 
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Color Picker 
Press the “Picker” button to display the color picker controls.  The color picker controls 
are shown below. 

 

 
 
The top and bottom of each character component can each be set to different colors.  
There are two boxes to select whether we want to change the top color, the bottom color, 
or both.  If the top and bottom colors are different, the text will be drawn with a smooth 
color spread between the two colors. 
 
Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds 
NTSC or PAL limitations, this box will appear red to indicate that you have selected an 
illegal color.  Otherwise this box will appear green. 
 
Below the illegal color indicator is the “Pick Color From Screen” button.  Pressing this 
button will change the appearance of the mouse to look like an eyedropper.  Move the 
mouse to any position on-screen that you want to copy the color of, press the left mouse 
button and the color under the mouse will be selected. 
 
To the right of these controls is the Hue Picker.  This lets you select the hue (red, green, 
blue, etc.) of the color.  Place the mouse over this control, and press the left mouse button 
to select the desired hue.  When the new hue is selected, the text will be redrawn with the 
new color, and the Color Picker Area (to the right of the Hue Picker) will also be drawn 
with the new hue. 
 
Once the Hue is selected you can now pick the color.  Place the mouse over the Color 
Picker Area and press the left mouse button.  This will select the color under the mouse.  
If you hold down the left mouse button while you move the mouse, the text will be 
redrawn with new color each time you select a new color by moving the mouse. 
 
You can also control the Transparency of the color.  The transparency setting can make 
the color fully opaque, semi-transparent, or fully transparent.  When a color is semi-
transparent, the text component is drawn as tinted over whatever is behind it.  When the 
color is fully transparent, it can’t even be seen on the screen.  Setting the transparency 
level to 0 makes the object fully opaque.  Setting the level to full (255) makes the object 
fully transparent.  Any value in between makes a color that is semi-transparent. 
 

 44



Chapter 4 - Text Styles 

There are a variety of ways to change the Transparency level.  Pressing the increase 
button to the right of the transparency number box will increase the level.  If you hold 
this button down the level will continue to increase until you release the button.  To 
decrease this value, press the decrease button.  Holding down this button will continue to 
decrease the value until it is released.  If you move the mouse over the transparency 
number box, then press and hold down the left mouse button, you can change the value 
by moving the mouse.  Moving the mouse up or to the right will increase the value.  
Moving the mouse down or to the left will decrease the value.  When you have selected 
the desired value, release the left mouse button. 
 
The value of the transparency level can be entered directly.  Do this by double-clicking 
the transparency number box (this will highlight all of the digits in the number), type in 
the new value and press the enter key. 
 
The color can be also mixed with background video.  Setting the video level to a value of 
zero makes the object the selected color.  Setting the video level to full (255) draws the 
object with background video.  Any value in between makes the object appear as 
background video that is tinted by the selected color.  For some very interesting effects, 
try blending colors, background video, and transparency over a background graphic 
image. 
 
The background video level can be adjusted in the same way as the transparency level. 
 
Color Sliders 
Press the “Sliders” button to display the Color Slider controls.  The Color Slider controls 
are shown below. 
 

 
 
The top and bottom of each character component can be set to different colors.  There are 
two check boxes to select whether we want to change the Top Color, the Bottom Color, 
or both the top and bottom colors.  If the top and bottom colors are different, the text will 
be drawn with a smooth Color Spread between the two colors. 
 
Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the 
NTSC or PAL limitations, this box will appear red to indicate that you have selected an 
illegal color.  Otherwise this box will appear green. 
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The Slate Generator has two (2) numerical systems for defining colors.  They are RGB 
(Red, Green, Blue) and HLS (Hue, Luminance, Saturation).  Both of these systems are 
used to define the same thing (like yards and meters).  Adjusting one will automatically 
change the other.  You can select which method to use by pressing either the RGB or 
HLS button.  You can switch back and forth between the 2 color systems at any time just 
by pressing the appropriate button. 
 
The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking 
the number box and entering the new value with the keyboard. 
 
Color Palette 
Press the “Palette” button to display the preset color palette.  The Color Palette is shown 
below. 
 

 
 
The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in 
this window.  Not all of the preset colors can be displayed at one time, so there is a scroll 
bar on the right hand side of the color palette entries.  Use this scroll bar to scroll through 
all of the preset colors. 
 
The top and bottom of each character component can be set to different colors.  There are 
two check boxes to select whether we want to change the Top Color, the Bottom Color, 
or both the top and bottom colors.  If the top and bottom colors are different, the text will 
be drawn with a smooth Color Spread between the two colors.   
 
Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds 
the NTSC or PAL limitations, this box will appear red to indicate that you have selected 
an illegal color.  Otherwise this box will appear green.   
To select a color from the preset color palette, position the mouse over the desired color 
and click the left mouse button.  You can change a color in the preset Color Palette by 
double clicking the entry that you want to change.  For more information about 
modifying the preset Color Palette, see the section "Modifying the Color Palette" in 
chapter 12. 
 
This window also has a button labeled "Background Video".  Pressing this button will set 
the color so that the text will be drawn with background video. 
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Color Gradients 
Press the "Gradient" button to display the color gradients.  The Color Gradients selection 
window is shown below. 

 

 
 
64 color gradients can be loaded into the system at one time.  The Color Gradients that 
are currently set are displayed in this window.  Not all of the color gradients can be 
displayed at one time, so there is a scroll bar on the right hand side of the Color Gradient 
entries.  Use this scroll bar to scroll through all of the color gradients that are currently 
set for the project. 
 
To select a color gradient, position the mouse over the desired gradient and click the left 
mouse button.  The text will then be drawn with the selected color gradient.  You can edit 
a Color Gradient, or build a new one, with the gradient builder.  To do this, double-click 
the Color Gradient that you want to modify.  For more information about using the 
gradient builder, see the section "Building Color Gradients" in chapter 12. 
 
Color Textures 
Press the "Textures" button to display the Color Textures selection window.  The Color 
Textures selection window is shown below. 

 

 
 
16 full Color Textures can be loaded into the system at one time.  The Color Textures 
that are currently loaded are displayed in this window.  The Textures are displayed large 
enough so that you can easily see what the texture looks like.  Not all 16 textures can be 
displayed in this window at one time, so there is a scroll bar on the right hand side of the 
textures.  Use this scroll bar to scroll through all of the textures that are currently loaded. 
 

 47  



Chapter 4 - Text Styles 

To select a Color Texture, position the mouse over the desired texture and click the left 
mouse button.  The text will then be drawn with the selected texture.  You can load a new 
texture by a double-clicking on the one that you want to replace.  When this is done you 
will be asked to specify which graphic image you want to load as a texture.  For more 
information about loading graphic images as Color Textures, see the section "Loading 
Textures" in chapter 12. 
 

Grabbing and Applying Attributes 
When you enter new text it is entered with the Current Text Attributes.  The text 
attributes specify how the characters, edges, and shadows will appear.  The Current Text 
Attributes are the attributes displayed in the Character, Edges, Shadows, and Colors 
control tab windows.  These include the following: 
 
Typeface 
Character Size 
Italics and rotation angles. 
Kerning 
Blur (character and edge) 
Edge Style (type, depth, direction) 
Shadow Appearance (shape and offset) 
Colors (character, edges, and shadows) 
 
When you overwrite text, the text keeps the attributes of the text that you are overwriting.  
If you would like to apply the Current Text Attributes to text that is already on the slate, 
use the "Apply Text Attributes" command.  Select the text that you want to change the 
attributes of, and press the "Apply Text Attributes" button in the Shortcut Buttons 
window. 
 
If you want to grab the text attributes from text that is on the slate, press the "Grab Text 
Attributes" button in the Shortcut Buttons window.  This will make the text attributes of 
the character under the cursor, the Current Text Attributes.  The new character attributes 
will then be displayed in the Character, Edges, Shadows, and Colors control tab 
windows. 
 

 48



Chapter 4 - Text Styles 

Text Style Gallery 
The "Text Style Gallery" window is used to hold preset text styles.  This is the window 
on the right side of your screen with all of the different type of "A's" in it.  The Text Style 
Gallery is designed to give you quick access to text styles that you will use frequently 
throughout the project.  You can save 64 different preset text styles in the Text Style 
Gallery.  However, you are not limited to just these 64 styles. 
 
Before we begin, create a new slate by pressing the "New Page" button on the toolbar.  
The program will warn you that you are about to erase the current slate.  Since we don't 
have a slate that is really worth saving, press the "Yes" button. You now have a new 
blank slate to work with. 
 
To enter text using one of the preset styles, select the desired text style (by clicking on it) 
and start typing.  Any new text that is entered will appear with the selected text style.  To 
select a different preset text style, click on it and start typing again. 
 
Select a text style that looks interesting and type "This is my first preset style".  Select 
another preset style and type "This is another one". 
 
To change the style of text that is already on the screen, select the text, then click on the 
style that you want to set it to.  Move the cursor to the first character and select another 
style from the style gallery.  Now, move the cursor to the next character and select 
another style.  Continue to do this for every character of the first two words of the slate. 
 
Select the word "first" by moving the mouse to the "f", press the left mouse button, and 
drag the mouse over to the "t" until the entire word is selected.  Then select another text 
style.  Notice that the entire word is changed. 
 
Select the Character tab in the Control Tabs Window and adjust the Height of the word 
"first".  Even though the character style was set using a preset style, you can still modify 
the style of the text.  So if you have a text style that is almost what you want, go ahead 
and select it, then modify the attributes of the text you just changed the style of, doing 
this will not affect the preset style in the style gallery. 
 
You can change the preset text styles.  Create a character on the slate that has the style 
that you want to use as a preset, place the cursor on it, and move the mouse pointer to the 
entry in the Text Style Gallery that you want to set to this style, and press the right mouse 
button.  A pop-up menu will appear.  Select the "Set Style" command.  The text style of 
the cursor character will be copied to the style gallery. 
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There are too many preset text styles to be shown at one time in the text style gallery.  
You can use the scroll bar to scroll through the preset text styles.  I like to group styles 
that are used together, near each other in the Text Style Gallery. 
 
Save this slate to the disk by pressing the "Save Page" button on the toolbar.  Give the 
slate the name "STYLES" and press the "Save" button.  You should see its Picon in the 
project manager window. 
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Layers 
 

The Slate Generator has 1000 layers available for text, shapes, and log
are completely independent of each other.  Changing something on on
affect the text on the other layers.  Each layer can be given a name.  E
moved in front of, or behind the other layers.  Individual layers can be
hidden so that they do not cover up the other layers that you're workin
 
To work with layers, use the "Layer Controls" (shown below).  You 
controls by selecting the "Layers” tab in the Controls Tab Window. 
 

 

Creating a New Layer 
Select a character height of about 48 scanline.  Enter enough text to fi
Move the mouse near the left margin about halfway down the screen. 
by holding down the <Ctrl> key while you press the left mouse button
 
The cursor is now positioned where you clicked the mouse on the new
the "layering order” list has a new entry called "layer 1".  This is the
list, so it will be the front layer on the screen.  Now enter the text "Thi
Notice that the new text appears in front of the original text.   
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Chapter 5 - Layers 
 
Move the cursor to the second row of the text on the original (Main) layer by clicking the 
mouse on it.  Notice that the name of the “Main” layer appears on the current layer on the 
status bar.  Insert a row at the cursor position by holding down the <Shift> key while you 
press the <Ins> key.  The text on the Main layer moved down to make room for the new 
row of text.  The text on Layer 1 did not move.  That is what we mean when we say the 
layers are completely independent of each other. 
 

Selecting a Layer 
You can select a new layer just by setting the cursor position to a character that is on that 
layer.  Move the mouse to any character on Layer 1 and click the left mouse button.  The 
cursor is moved to the character that you clicked with the mouse, and the status bar is 
updated to show that you are now on Layer 1. 
 
You can also select a new layer from the "Layering Order” list.  When this is done, the 
cursor will be placed on the first character of the selected layer. 
 

Renaming Layers 
When the new layers are created, they are given a default name such as "Layer 1".  
When that layer is selected the name appears on the status bar and in the "Layer Name" 
box in the Layers Control Window.  You can change the name of the layer just by 
entering the new name in the "Layer Name” box.  When the name is changed, the name 
appears in the "Layering Order” list and on the status bar. 
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Changing Layer Priority 
When a new layer is created, it is given the highest priority so that it will be displayed in 
front of all the other layers.  The priority of each layer is displayed in the "Layering 
Order” list".  The top layer in the list is the highest priority layer and is in front of all the 
other layers on the slate.  The bottom layer in the list is the lowest priority layer and is 
behind all of the other layers.  A layer is in front of all of the layers that are listed below 
it in the layering list, and behind all of the layers that are listed above it. 
 
Each layer can be moved in front of, or behind the other layers.  This can be done using 
the layer priority buttons (shown below). 
 
 

 

Move layer to top 
This gives the current layer the highest priority, 
and places it in front of all other layers 

 

 

Move layer up one layer 
This moves the current layer up 1 level in priority; 
this places it in front of the next layer up. 

 

 

Move layer down one layer 
This moves the current layer down one level in 
priority; this places it behind the next layer down. 

 

 

Move layer to bottom 
This gives the current layer the lowest priority, 
and places it behind all other layers. 

 
Dragging it from its current position to the new position in the “Layering Order” list can 
also change a layers priority.  Move the mouse to the layer that you want to change the 
priority of in the "Layering Order" list.  Hold down the left mouse button and drag the 
layers name to the desired priority.  The slate will then be redrawn with the layer 
displayed at the new position. 
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Hiding Layers 
When you start getting a lot of layers on a slate, and you need to make a change to 
something that is on a low priority layer, the things that you want to change may be 
difficult to see because of the layers in front of it.  There are two ways to make the low 
priority of layers more visible.  One way is to increase the layers priority, edit the text, 
then move the layer back to its lower priority.  The other method is to "Turn Off" the 
layers in front.  This is done by telling the program which layers you don't want to see. 
 
On the right hand side of the Layers Control Window are 2 buttons (“Displayed” and 
“Hidden”).  These buttons show whether or not the current layer is displayed or hidden.  
To hide a layer, select the layer that you want to hide and press the "Hidden" button.  
The slate is then redrawn without the selected layer.  To turn the layer back on, press the 
"Displayed" button, and the slate is redrawn with the layer. 
 
Another really neat thing that hidden layers allow you to do it is to easily create multiple 
slates that all have common information.  Place the text that is common to all slates on 
one or more layers.  Place text that is common to more than one (but not all) slates on 
other layers.  Then compose the text that is unique to each slate on its own separate layer.  
This gives you a master slate. 
 
Copy the master slate once for each slate that you want to create.  And hide the layers 
that you do not want to show on each individual slate.  If you ever need to modify the 
text, you can modify the master slate (instead of each individual slate) then copy the 
slates and hide the appropriate layers again.  This avoids any differences (such as 
positioning errors) in the slates. 
 

Deleting Layers 
If a layer has no text on it, you may want to delete it.  You can do this by selecting the 
layer and pressing the "Delete Layer" button in the Layer Controls Window.  If there is 
text on the layer that you're trying to delete, a warning message (like the one below) will 
appear telling you that if you delete the layer, all of the text on that layer will also be 
deleted. 
 

 
 
If you want to delete the text that is on this layer, press the "Yes" button.  Otherwise 
press the "No" button. 
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Moving Text 
 
Once the text has been entered, it can be moved around and positioned.  This can be done 
either automatically or manually.  Automatic positioning of slates consists of word 
wrapping, word unwrapping, centering the text between the margins, justifying the text to 
the margins, or removing excess row spacing from between the rows. 
 
Manual positioning of the text allows you to move the text to nearly any position on the 
screen. 
 
To do automatic text positioning, use the “Positioning Controls” (shown below).  You 
can display these controls by selecting the “Positioning” tab in the Control Tab Window. 
 

 
 

Word Wrapping and Unwrapping 
Let's start with a fresh slate by pressing the "New Page" button on the toolbar.  A 
warning may appear telling you that the current slate is going to be erased.  If this 
happens press the "Yes" button.  You now have a new slate to work with. 
 
Set the character height to 48 scanline, and the character width to 100%.  Now enter the 
following text without pressing the <Enter> key "This Slate Generator software is really 
pretty easy to use".  Notice that when you got to the right side of the screen, the cursor 
automatically went to the beginning of the next row. 
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Some of the words extend beyond the right margins.  There are two common methods of 
fixing this.  The first method is to make the text smaller so that it will fit.  The other 
method is to wrap the words that extend beyond the margin to the next row.  Since this 
section deals with word wrapping and unwrapping, let's try wrapping the words. 
 
The "Word Wrap/Unwrap" section of the "Positioning Controls Window" has four 
buttons.  These buttons are as follows: 
 

 
Wrap One Word 

 
Wrap All Words 

 
Unwrap One Word 

 
Unwrap All Words 

 
Word Wrap checks to see if the last word of the row extends beyond the right margin.  If 
it does, the word is moved to the beginning of the next row.  Word Unwrap checks to see 
if the first word of the next row will fit on the current row.  If it will, the word gets 
moved up to the row above. 
 
Move the cursor to the home position by pressing the <Home> key twice.  Press the 
"Wrap One Word" button (in the positioning controls window).  If the last word of the 
cursor row extends beyond the right margin, it gets moved to the next row. 
 
If there is a word that needs to be wrapped, one word gets wrapped to the next row each 
time you press this button.  If there is not a word that needs to the wrapped, pressing this 
button will move the cursor to the beginning of the next row.  Press the "Wrap One 
Word" button until all words that need it are wrapped to the next row and the cursor 
moves to the next row.  You could continue to wrap the entire slate this way, but there is 
an easier way to do it.  Press the "Wrap All Words" button.  All of the words on the slate 
that need to be word wrapped are moved to the next row. 
 
Select all of the text on the slate by selecting "Entire Page" in the scope selection box on 
the toolbar.  Decrease the height of the text to 32 scanline using any method that you 
prefer.  The rows of text got narrower so that you can now fit more text on each of the 
rows. 
 
Move the cursor back to the home position by pressing the <Home> key twice.  Press the 
"Unwrap One Word" button.  The first word of the next row should move up to the end 
of the cursor row if there's room for it.  Press the "Unwrap All Words" button.  Every 
word on the slate will unwrap to fill in the excess space at the end of each row. 
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Row spacing (Leading) 
Notice that when you decreased the height of the characters that the height of the rows 
did not automatically get smaller.  The rows now seem to be spaced too far apart.  To set 
the row to the height that they should be, press the "Preset Row Spacing" button in the 
shortcut buttons window.  The height of each row will automatically adjust to what it 
should be for the height of the tallest character on the row. 
 
You can have more control over the rows spacing (leading) with the "Row Spacing" 
controls.  Display these controls (shown below) by selecting the "Row Spacing" tab in 
the control tab window. 
 

 
 
These controls are used to increase/decrease the spacing between the rows.  The row 
spacing can be increased by pressing the "More" buttons.  The row spacing can be 
decreased by pressing the "Less" buttons.  To set the row spacing back to what it should 
be (based on the text on the row) press the "Set Default Row Spacing" button. 
 
The buttons in the "Change Row Spacing of" section of this window are used to select 
which row(s) we are going to change the row spacing of. 
 
Cursor Row 
Changes the row spacing of the row that the cursor is on. 
 
Entire Layer 
Changes the row spacing of every row on the current layer. 
 
Entire Page 
Changes the row spacing of every row on the slate. 
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Fine Positioning Text 
Individual characters, words, rows, layers, and the entire slate can be fine positioned in 
single pixel/scanline increments.  Characters can be moved to any position on the row 
and can be made to completely overlap each other.  Smaller characters can be positioned 
inside of larger characters.  Rows can even be positioned to allow text to overlap the text 
of other rows. 
 
There are three ways to fine position text around the screen.  One method is to use the 
cursor handles.  Another method is to drag the text by moving the mouse while holding 
down the right mouse button.  The final method is to use the fine positioning buttons in 
the positioning control tab window. 
 
To use the cursor handles, select the character tab in the control tab window and turn the 
cursor handles on by pressing the “Cursor Handles” button.  Little rectangles will appear 
around the cursor.  These are the cursor handles.  The handle in the lower left hand 
corner will move the text both horizontally and vertically.  The handle on the left side of 
the mouse will move the text horizontally only.  Any accidental vertical movement of the 
mouse will not move the text vertically.  The handle on the bottom of the cursor will only 
move the text vertically.  Accidental horizontal movement of the mouse will not move 
the text horizontally. 
 
To move text with these handles, select the text to move by dragging the mouse over the 
desired text.  Position the mouse over the handle that you want to use and the cursor will 
change to arrows that show which direction the text can be moved.  Press and hold down 
the left button of the mouse, then move the mouse.  The text will follow the mouse until 
you release the left mouse button. 
 
If the Cursor Handles clutter up the screen too much for your taste, you can turn them off 
by pressing the “Cursor Handles” button again (once you are finished moving the text). 
 
You can quickly move the text (both horizontal and vertical) without turning on the 
cursor handles.  To do this, select the text that you want to move and press and hold 
down the right hand button of the mouse.  As you move the mouse, the text will follow it 
until you release the right mouse button. 
 

 58



Chapter 6 - Moving Text 

To use the fine positioning buttons to move the text, display the Fine Positioning Buttons 
by pressing the "Positioning" tab in the control tab window.  This will display the 
Positioning Controls Window as shown below. 
 

 
 
Use these buttons to do fine incremental positioning of text.  The single arrow buttons 
will move the selected text one pixel each time you press it.  The double arrow buttons 
move the selected text in bigger steps. 
 
The "Reset Text Position" button will restore the text to its original (before it was moved) 
position. 
 

Centering and Justifying Text 
The Positioning Tab Window has 8 types of centering and justifying controls.  These are: 
 

 

Left Justify 
Notice how all of the lines are lined up with the left margin. 

 

Right Justify 
Notice how all of the lines are lined up with the right margin. 

 

Horizontal Centering 
Notice how all of the lines are centered between the left and right margins. 

 

Justify to Left and Right Margins 
Notice how all of lines are lined up with both the left and right margins. 

 

Vertical Centering 
The text is adjusted vertically to position it in the center of the screen. 

 

Center Horizontally and Vertically 
The text is adjusted horizontally and vertically to position it in the center of the screen. 

 

Top Justify 
The text is adjusted vertically so that the top row is placed at the top margin. 

 

Bottom Justify 
The text is adjusted vertically so that the bottom row is placed at the bottom margin. 
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The "Row" section of the "Positioning Controls Window" (shown below) has four 
buttons.   
 

 
 
These buttons are used to control individual rows of text.  Each row can be centered 
horizontally or justified to the left margin, right margin, or both margins at the same time. 
 
To center a row, place the cursor on the row that you want to center and press the 
"Horizontal Centering" button.  The row is now centered horizontally between the left 
and right margins. 
 
To justify the row to the right margin, press the "Right Justify" button in the "Row" 
section of the "Positioning Controls Window".  This moves the text to the right so that it 
is aligned to the right margin.  Press the "Left Justify" button in the "Row" section.  The 
text moves to the left so that it is aligned to the left margin. 
 
To justify the row to both margins at the same time, press the "Justify to Left and Right 
Margins" button in the "Row" section.  The first character of the row is placed at the left 
margin, and the spacing between the characters is adjusted so that the last character of the 
row is aligned to the right margin. 
 
To perform the centering and justifying functions on all of the rows of text on the slate 
(or on the layer), use the corresponding buttons in the "Layer/Page" section of the 
"Positioning Controls Window" (shown below).   
 

 
 
This section has two buttons (Layer and Page) to select whether each operation will be 
done on every row on the layer or every row on the slate. 
 

 60



Chapter 6 - Moving Text 

Select the "Page" button to make the centering and justifying functions work on every 
row of the slate.  Try pressing the "Horizontal Centering", "Right Justify", "Left Justify", 
and "Justify to Left and Right Margins" buttons in the "Layer/Page" section.  Notice that 
the functions are now done to every row on the slate. 
 
Press the "Center Horizontal and Vertical" button (shown here) to center the entire slate 
(or layer) both horizontally and vertically. 

 
 
Press the "Top Justify" button (shown here) to move the entire slate (or layer) to the top 
margin. 

 
 
Press the "Bottom Justify" button (shown here) to move the entire slate (or layer) to the 
bottom margin. 

 
 
Press the "Vertical Centering" button (shown here) to center the slate (or layer) vertically 
between the top and bottom margins. 
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Logos 
 
As many as 16 different full color logos can be placed on each slate.  T
loaded directly from GIF, TIF, TGA, BMP, PCX, JPG, or JPEG image
used as a logo has an alpha channel, the alpha channel is supported. 
 
To add a logo to a slate, select the “Logos” tab in the Logos Controls 
controls will be displayed as shown below. 
 

 
If the cursor is currently on a logo, information about that logo is disp
window.  The name of the image file that contains the logo is displaye
also indicates the maximum size (height and width) that the logo can b
 

Placing a Logo on the Slate 
This window also has an "Add New Logo" button.  To add a new log
position the cursor where you want the logo to appear.  You may want
layer for the logo, but you don't have to.  Press the " Add New Logo "
the graphic image that you want to use as the logo.  The logo will then
current character height.  Once a logo is added to a slate you can size 
you would a character. 
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Chapter 7 - Logos 
 

Sizing a Logo 
The maximum size that a logo can be displayed on a slate is 640 by 480 pixels or the 
original size of the logo (whichever is smaller).  If a graphic image was created at 100 
scan lines high, it cannot be displayed larger than 100 scan lines. 
 
When a logo is first loaded it is displayed at the current character height.  The 
"Maximum Height" and "Maximum Width" entries in the Logo Control Window will 
be updated to indicate the maximum height and width that this logo can be displayed. 
 
To change the size of a logo, position the cursor on it, and then change the size of it just 
as if it was a character.  You can use the "Height" and "Width" controls in the "Character 
Controls Window” to vary the logos height and relative width.  You can also use the 
cursor handles to change the logos height and width. 
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Shapes 
 
Shapes are boxes that you can control the roundness and the aspect ratio of.  Once the 
shape has been placed on the slate you can size it, colorize it, add edges and shadows to 
it, and even rotate it.  In fact you can do anything to a shape that you can do to a 
character (except change the typeface of it).  A “Foreground Shape” gets inserted into 
the current layer at the cursor position.  A “Background Shape” gets added to a new 
layer that is automatically created behind the text that is currently selected. 
 
To create or edit a shape select the "Shapes" tab in the "Control Tabs Window".  The 
shape controls window will be displayed as shown below. 
 

 
 

Aspect Ratio 
The “Aspect Ratio” of the shape can be changed from tall and skinny to very wide.  The 
aspect ratio can also be changed by changing the relative width (using the Character 
Width Controls).  The character width does have a limited range of 10% to 500%.  The 
aspect ratio controls are used to extend this range. 
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Roundness 
The “Roundness” of the shape can be set to any value from 0 to 100%.  A Roundness of 
0% creates a shape that has square corners.  A Roundness of 100% creates the shape that 
is either a circle or an ellipse (depending on its aspect ratio).  A value between 1 and 99% 
creates a box that has rounded corners.  The amount that the corners are rounded is 
determined by the Roundness setting. 
 

Foreground Shapes 
Add a foreground shape by moving the cursor to the desired position and press the "Add 
Foreground Shape" button.  The new shape is inserted at the cursor position.  The 
shape is assigned the Current Character Attributes.  To increase the width of the shape 
using the aspect ratio controls, drag the aspect ratio slider to the right.  To decrease the 
width, drag this slider to the left.  Use the “Roundness” control to adjust the roundness 
of the shape.  Dragging the “Roundness” slider to the right will make the shape rounder; 
dragging it to the left will make it squarer. 
 
Now that the shape is on-screen you can use the "Character", "Edges", "Shadows", 
and "Colors" controls to modify the various character attributes of the shape.  The 
program creates the shape as if it were a character.  All of the controls that can be used to 
change the appearance of a character can be used to change the appearance of a shape. 
 

Background Shapes 
Enter the words "Background Shape" on the slate.  Drag the mouse across all the 
characters of both words to select them.  Now press the "Add Background Shape" 
button.  A new shape is created behind the selected text.  A new layer was automatically 
created for this shape and placed behind the text. 
 
This shape is exactly like the foreground shape except that it's on a separate layer.  You 
can change the character attributes just like you can a foreground shape or a character. 
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The Slate Generator can display background color boxes over the background image (or 
external video) and behind the text.  Each background color box can be positioned and 
sized to anywhere on the screen.  The color box can be set to a solid color, a smooth 
color spread between the top and bottom of the box, a color gradient (a four or five point 
area gradient, or a linear gradient with up to 16 colors), or a full color texture.  If the 
background color boxes have a solid color, a color spread, or a color gradient, the 
transparency and background video levels of each color point can be adjusted. 
 
As many as 32 background color boxes can be used on each slate.  Each background 
color box is assigned to its own layer.  The background color layers are always behind 
the text layers and in front of the background image.  The priority that each background 
color box is assigned determines how they will appear when one background color box 
overlaps another.  A background color box that has a higher priority will appear in front 
of color boxes that have lower priorities. 
 
 To create or edit a background color box select the "Background-Colors" tab in the 
Control Tabs window.  The Background Color Box Controls (shown below) will be 
displayed. 
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Creating a New Background Color Box 
To create a new background color box press the "New Background Color Box" button.  
A new color box will appear behind the cursor row.  The background color box begins as 
a semi-transparent gray that is the full width of the screen, and the height of the cursor 
row. 
 
The cursor appears to surround the new background color box.  The cursor has six cursor 
handles.  Three of these handles (on the left and bottom of the cursor) are used to position 
the color box.  The other three handles (on the top and right of the cursor) are used to size 
the color box. 
 

Moving and Sizing Background Color Boxes 
Use the handle at the top of the cursor to adjust the height of the color box.  Use the 
handle on the right side of the cursor to adjust the width of the color box.  Dragging the 
handle on the upper right corner of the cursor will adjust both the height and width of the 
color box. 
 
You can move the Background Color Box in any direction by clicking on the handle in 
the lower left corner of the cursor and dragging the mouse.  If you want to move the color 
box horizontally only (without moving it vertically) use the handle on the left side of the 
cursor.  The handle on the bottom of the cursor will move the color box vertically 
(without changing the horizontal position). 
 

Changing Background Color Box Color 
There are five different ways of selecting a color for the background color box.  These 
methods are as follows: 
 
Color Picker 
The color picker lets you select the color using a visual approach. 
 
Color Sliders 
The color sliders let you select a color using a numerical approach. 
 
Color Palette 
The color palette lets you select a color from a palette of 64 (User Definable) preset 
colors. 
 
Color Gradient 
A color can be selected from a group of 64 user-defined color gradients.  These may be 
either a linear gradient with up to 16 color points that can be rotated up to 90 degrees in 
either direction, or an area gradient that can have four or five color points defined. 
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Color Texture 
A color texture can be selected from any of the 16 textures that are currently loaded. 
 
Color Picker 
Press the "Picker" button to display the color picker controls.  The color picker controls 
are shown below. 
 

 
 
The top and bottom of each background color box can be set to different colors.  There 
are two boxes to select whether we want to change the top color, the bottom color, or 
both.  If the top and bottom colors are different, the color box will be drawn with a 
smooth color spread between the two colors.  The top and bottom transparency and 
background video levels can also be set independently. 
 
Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds 
NTSC or PAL limitations, this box will appear red to indicate that you have selected an 
illegal color.  Otherwise this box will appear green. 
 
Below the Illegal Color Indicator is the "Pick Color From Screen" button.  Pressing 
this button will change the appearance of the mouse cursor to look like an eyedropper.  
Move the mouse to any position on the screen that you want to copy the color of, press 
left mouse button and the color under the mouse will be selected. 
 
To the right of these controls is the Hue Picker.  This is used to select the hue (red, 
green, blue, etc.) of the color.  Place the mouse over this control, and press the left mouse 
button to select the desired Hue.  When the new hue is selected, the background box will 
be redrawn with the new color, and the Color Picker Area (to the right of the Hue 
Picker) will also be drawn with the new hue. 
 
Once the hue is selected you can now pick a color.  Place the mouse over the Color 
Picker Area and press the left mouse button.  This will select the color under the mouse.  
If you hold down the left mouse button while you move the mouse around the Color 
Picker Area, the background color box will be redrawn with the new color each time 
you select a new color by moving the mouse. 
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You can also control the Transparency of the color.  The Transparency setting can 
make the color fully opaque, semi-transparent, or fully transparent.  When a color is 
semi-transparent, the text component is drawn tinted over whatever is behind it.  When 
the color is fully transparent, it can't even be seen on-screen.  Setting the transparency 
level to 0 makes the object fully opaque.  Setting the level to full (255) makes the object 
fully transparent.  Any value in between makes a color that is semi-transparent. 
 
There are a variety of ways to change the Transparency level.  Pressing the increase 
button to the right of the transparency number box can increase the level.  If you hold this 
button down, the level will continue to increase until you release the button.  To decrease 
this value, press the decrease button.  Holding down this button will continue to decrease 
the value until it is released.  If you move the mouse over the transparency number box, 
then press and hold down the left mouse button, you can change the value by moving the 
mouse.  Moving the mouse up or to the right will increase the value.  Moving the mouse 
down or to the left will decrease the value.  When you have selected the desired value, 
release the left mouse button. 
 
The value of the transparency level can be entered directly.  Do this by double-clicking 
the transparency number box (this will highlight all of the digits in the number), type in 
the new value and press the enter key. 
 
The color can be also mixed with background video.  Setting the video level to a value of 
0 makes the object the selected color.  Setting the video level to full (255) draws the 
object with background video.  Any value in between makes the object appear as 
background video that is tinted by the selected color.  For some very interesting effects, 
try blending colors, background video, and transparency over a background graphic 
image. 
 
The background video level can be adjusted in the same way as the transparency level. 
 
Color Sliders 
Press the "Sliders" button to display the Color Slider Controls.  The Color Slider 
Controls are shown below. 
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The top and bottom of each Background Color Box can be set to different colors.  There 
are two check boxes to select whether we want to change the Top Color, the Bottom 
Color, or both the top and bottom colors.  If the top and bottom colors are different, the 
Background Color Box will be drawn with a smooth Color Spread between the two 
colors. 
 
Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the 
NTSC or PAL limitations, this box will appear red to indicate that you have selected an 
illegal color.  Otherwise this box will appear green. 
 
The Slate Generator has two (2) numerical systems for defining colors.  They are RGB 
(Red, Green, Blue) and HLS (Hue, Luminance, Saturation).  Both of these systems are 
used to define the same thing (like yards and meters).  Adjusting one will automatically 
change the other.  You can select which method to use by pressing either the RGB or 
HLS button.  You can switch back and forth between the 2 color systems at any time just 
by pressing the appropriate button. 
 
The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking 
the number box and entering the new value with the keyboard.   
 
Color Palette 
Press the “Palette” button to display the color palette.  The Color Palette is shown 
below. 
 

 
 
The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in 
this window.  Not all of the preset colors can be displayed at one time, so there is a scroll 
bar on the right hand side of the color palette entries.  Use this scroll bar to scroll through 
all of the preset colors. 
 
The top and bottom of each Background Color Box can be set to different colors.  There 
are two check boxes to select whether we want to change the Top Color, the Bottom 
Color, or both the top and bottom colors.  If the top and bottom colors are different, the 
Background Color Box will be drawn with a smooth Color Spread between the two 
colors.   
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Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds 
the NTSC or PAL limitations, this box will appear red to indicate that you have selected 
an illegal color.  Otherwise this box will appear green.   
 
To select a color from the preset color palette, position the mouse over the desired color 
and click the left mouse button.  You can change a color in the preset Color Palette by 
double clicking the entry that you want to change.  For more information about 
modifying the preset Color Palette, see the section "Modifying the Color Palette" in 
chapter 12. 
 
This window also has a button labeled "Background Video".  Pressing this button will 
set the color so that the Background Color Box will be drawn with background video. 
 
Color Gradients 
Press the "Gradient" button to display the color gradient selection window.  The Color 
Gradient selection window is shown below. 
 

 
 
64 color gradients can be created for each project.  The Color Gradients that are currently 
set are displayed in this window.  Not all of the color gradients can be displayed at one 
time, so there is a scroll bar on the right hand side of the Color Gradient entries.  Use this 
scroll bar to scroll through all of the color gradients currently set for the project. 
 
To select a color gradient, position the mouse over the desired gradient and click the left 
mouse button.  The Background Color Box will then be drawn with the selected color 
gradient.  You can edit a Color Gradient, or build a new one, with the gradient builder.  
To do this, double-click the Color Gradient that you want to modify.  For more 
information about using the gradient builder, see the section "Building Color Gradients" 
in chapter 12. 
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Color Textures 
Press the "Textures" button to display the Color Textures selection window.  The Color 
Textures selection window is shown below. 
 

 
 
16 full Color Textures can be loaded into the system at one time.  The Color Textures 
that are currently loaded are displayed in this window.  The Textures are displayed large 
enough so that you can easily see what the texture looks like.  Not all 16 textures can be 
displayed in this window at one time, so there is a scroll bar on the right hand side of the 
textures.  Use this scroll bar to scroll through all of the textures that are currently loaded. 
 
To select a Color Texture, position the mouse over the desired texture and click the left 
mouse button.  The Background Color Box will then be drawn with the selected texture.  
You can load a new texture by a double-clicking on the one that you want to replace.  
When this is done you will be asked to specify which graphic image you want to load as 
a texture.  For more information about loading graphic images as Color Textures, see the 
section "Loading Textures" in Chapter 12. 
 

Full-Screen Background Color 
To create a background color box that covers the full-screen, press the "Full Screen 
Background Color" button.  A new background color box (that is a semi transparent 
gray) will be created that covers the entire slate. 
 

Selecting Background Color Box 
You can only edit one background color box at a time.  Before you can modify a 
background color box you need to select it.  The selected color box is displayed with a 
cursor (rectangular box) around it.  The cursor also has six small boxes attached to it.  
These are called cursor handles, they are used to size and position the background color 
box. 
 
Background color boxes can be selected by clicking the mouse on the desired one.  If 
more than one background color box overlap, keep clicking the left mouse button until 
the one you want is selected. 
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Changing Color Box Priority 
Each color background box is placed on its own separate layer (behind the text layers and 
in front of the background graphic image).  The priority of each background color box 
determines how it will appear when one color box is overlapped by another.  The 
background color boxes that have a higher priority will appear in front of color boxes that 
have a lower priority. 
 
The background color controls have four buttons that are used to change the priority of 
the background color boxes.  These buttons allow you to move the background color 
boxes in front of, or behind other color boxes when they overlap.  These buttons are 
shown below. 
 

 

Press this button to move the current background color box to the highest 
priority.  When this is done it will appear in front of all other background 
color boxes. 

 

Press this button to increase the priority of the current background color 
box by one.  This will place the color box in front of the color box that 
had the next higher level of priority (if they overlap). 

 

Press this button to decrease the priority of the current background color 
box by one.  This will place the color box behind the color box that had 
the next lower level of priority (if they overlap). 

 

Press this button to move the current background color box to the lowest 
priority.  When this is done it will appear behind all of the other 
background color of boxes. 

 

Converting a Background Color Box to a Shape 
A background color box can be converted to a shape by pressing the "Convert Color 
Box to Shape" button.  When this is done the color box is placed in front of all the other 
background color boxes.  Once a background color box has been converted to a shape, it 
cannot be converted back to a Background Color Box. 
 
When a background color box is made into a shape, it can be italicized, rotated, and 
rounded just like any other shape.  It can also have edges and shadows added to it just 
like any other character. 
 

Deleting a Background Color Box 
To remove a background color box from the slate, select the background color box that 
you want to delete by positioning the mouse over it and clicking the left mouse button.  
Once it is selected, press the "Delete Background Color Box" button.  This will delete 
the current background color box. 
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Background Images 
 
The program can display either a graphic image or a background video
your system is capable of overlying titles over video) behind the text. 
graphic can be in any of the following graphic formats: 
 
Windows bitmap (BMP) 
TIFF 
Targa (TGA) 
PCX 
GIF 
JPG 
JPEG 
 
These are standard graphic formats that can be generated by many thir
packages.  If no background graphic image is selected, the text will be
background video source (if your system is capable of this). 
 
A background graphic can be displayed in either original size, scaled t
screen, or tiled to fill the screen.  When the graphic is displayed with i
may or may not fill the entire screen.  When a graphic is displayed ful
(either up or down) to match the screen dimensions.  When the graphi
displayed in its original size and is repeated enough times to fill the en
 
To change the background image, select the "Background - Image" 
Tabs window.  The Background Image Controls (shown below) w
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No Graphic (Background Video) 
Special hardware or software (if the program is running as a plug in) is required to 
overlay the titles over video.  Some systems are not capable of this.  If your system is not 
capable of overlaying titles over video, the background will be displayed as black. 
 
To overlay the title over background video, press the "No Graphic (Background 
Video)" button.  Any background graphic that may have been displayed will disappear 
and the text will be displayed over the background video. 
 

Graphic - Original Size 
When you load a graphic to be displayed in its original size, the graphic may be smaller 
than the screen, the same size as the screen, or larger than the screen.  To load a graphic 
in its original size, press the "Graphic-Original Size" button.  A window will appear 
asking you to select the Background Graphic.  Select the graphic image that you want to 
load as a background and press the "Open" button.  The selected graphic will be loaded. 
 
If the graphic is smaller than the screen, it will be centered on the screen, and the 
positioning buttons that are used to change graphic position will be displayed. 
 
If the graphic is the same size as the screen, it will be displayed as a full-screen image.  If 
the graphic is larger than screen, a warning message (like the one shown below) will 
appear. 
 

 
 
At this point you have the option of shrinking the graphic so that the entire image will fit 
on the screen, or displaying the graphic in its original size and cutting off the outside 
edges of the graphic.  To display the graphic without shrinking it, press the "No" button.  
The new graphic will then loaded as the background. 
 
To shrink the background graphic so that all of it will be displayed, press the "Yes" 
button.  This will load the graphic "Full-Screen".  See the section below (Graphic-Full 
Screen) for more information. 
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Graphic - Full Screen 
When you load a graphic to be displayed full-screen, and the original size of the graphic 
is not the same as screen dimensions, the graphic must be scaled before it will fit the 
screen.  If the graphic is smaller than the screen, it will be enlarged.  If the graphic is 
larger than the screen, it will be reduced in size. 
 
A video screen has a fixed aspect ratio of 4 by 3 (or 16 by 9).  This means that the screen 
wider than it is tall.  If the background graphic image has a different aspect ratio (maybe 
it's taller than it is wide), the height and the width will need to be scaled by different 
amounts to make the image fill the entire screen.  This can distort the image.  It can make 
people look very fat, or very tall. 
 
Before the background image is loaded full-screen the aspect ratio of the graphic is 
checked to see if it matches the screens aspect ratio.  If the aspect ratios are different, a 
warning message (like the one shown below) is displayed. 
 

 
 
If you choose to preserve the aspect ratio, the background graphic will be scaled 
horizontally and vertically by the same amount.  This will prevent the image from being 
distorted.  However the graphic will not fill the screen both horizontally and vertically. If 
the image is too tall, it will not fill the screen horizontally.  If the image is too wide, it 
will not fill the screen vertically. 
 
If you choose not to preserve the aspect ratio, the background image will be scaled 
horizontally and vertically the amount necessary to fill the entire screen.  If this results in 
unacceptable distortion, simply load the background graphic again.  This time preserve 
the aspect ratio. 
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Graphic - Tiled 
If a graphic image is smaller than the screen, it can be tiled in the background.  This will 
display the background graphic in its original size.  The graphic will be repeated 
horizontally and vertically to fill the entire screen. 
 
To tile a background graphic, press the "Graphic - Tiled" button. A window will appear 
asking you to select the background graphic.  Select the graphic image that you want to 
load as a background and press the "Open" button.  The selected graphic will be loaded 
and tiled. 
 
If the graphic is larger than the screen, a warning message (like the one shown below) 
will appear. 
 

 
 
At this point you have the option of shrinking the graphic so that the entire image will fit 
on the screen, or displaying the graphic in its original size and cutting off the outside 
edges of the graphic.  To display the graphic without shrinking it, press the "No" button.  
The graphic will then be loaded as the background.  Portions of the graphic image will be 
cut off. 
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Project Settings 
Projects are a convenient way of keeping groups of slates and project settings separate 
from each other.  When a new project is created Slate Generator creates a new folder 
(with the same name as the project) on your system.  Whenever you are working in this 
project, the slates will be read from and written to this folder as the default.  All slates 
that are in this folder will appear in the Project Manager window. 
 
The system default settings are saved in the project file.  This file has the same name as 
the project with a .SET extension (for example, the project MY_PROJECT would be 
defined in a file called MY_PROJECT.SET).  This file contains the following system 
default settings: 
 
• Character Attributes 
• Style Gallery 
• Color Gradients 
• Default Color Palette 
• Loaded Typefaces 
• Loaded Textures 
• Default Directory/Folders 
• Safetitle Margins 
• Tab Settings 
 
When a new project is created, the current system settings are saved as the Project 
Defaults.  When the project is opened again, these settings will be restored as the default 
settings. 
 
You can update the default settings of the project by selecting the "Save Project 
Settings" command in the "File" menu.  The current systems settings will be saved as 
the Project Defaults. 
 
When you exit the program, or you open another project, a message window may appear 
(depending on your Preference Settings) asking you if you want to save the current 
settings.  This window is shown below: 
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If you press the "Yes" button, the project settings will be updated to match the current 
settings. 
 

Project Manager 
The Project Manager is used to give you quick access to all of the slates in the project.  
This window (shown below) is on the left hand side of the screen. 
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All of the slates in the current project are displayed in this window.  The slates are 
represented both by Picons and the name of the slates.  A PICON (Picture ICON) is a 
miniature picture of the slate.  With Picons you can tell at a glance what the slate looks 
like.  You can open any slate in the project just by clicking on it in the Project Manager 
window.  If there are too many slates in the project to be displayed at one time, you can 
scroll through the list of slates using the Project Managers scroll bar. 
 
Slates can be created, opened, saved, copied, deleted, and exported from the menu that 
appears when you position the mouse over the project manager and click the right mouse 
button.  This menu is shown below. 
 

 
 
This menu also has commands for creating a New Project, Opening an existing Project, 
and Saving the current settings as the Project default Settings.  These menu commands 
can also be selected from the "File" menu. 
 

Creating a New Project 
When a new project is created, the current systems settings are saved as the new project 
defaults.  So, before you create a new project, you should open an existing project that 
has systems settings similar to the default system settings that you want the new project 
to have. 
 
To create a new project, select the "New Project" command from the "File" or “Project  

 
 
Enter the name of the new project where it says "New Project Name" and press the 
"Create" button.  The name of the new project now appears at the top of the project 
manager.  Since we haven't created any slates for the new project yet, no slates appear in 
the list.  As you create slates for this new project they will appear in the Project Manager 
window. 
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Open an Existing Project 
To open a project that already exists, select the "Open Project" command from the 
"File" or Project Manager menus.  Once this is done the "Load New Project Settings" 
window (shown below) will appear. 
 

 
 
Use this window to select which project to open and press the "Open" button.  When the 
new project is opened, the new project’s system settings will be loaded.  The old project 
settings will be overwritten.  Before the old project settings are lost, you may be given 
the chance to save them (if the User Preferences are set accordingly).  If so the following 
window will appear. 
 

 
 
You can save the old system settings to the old project file by pressing the "Yes" button.  
Pressing the "No" button will open the new project without saving the system settings. 
 
Once the new project is opened, the slates in the project will appear in the Project 
Manager window. 
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Save Project Settings 
To save the current settings as the project defaults, select the “Save Project Settings” 
command from the “File” or Project Manager menus.  The current project settings will be 
saved to the Settings (.SET) file so that they can be restored the next time this project is 
opened. 
 

Slates 
When slates are saved on the disk, they are each saved in a separate file.  The sizes of 
these files are determined by the amount of text and the complexity of the slate.  Most 
slates are smaller than 1 or 2 Kbytes unless they contain logos or textures.  Hundreds of 
slates can be stored on a floppy disk and millions can be stored on a hard drive.  Each 
slate file can be given a unique name.  The “.PAG” extension is added to the slate name 
to create the file name that the slate will be stored under. 
 
The slates are stored in a format that allows them to be fully edited, even after they are 
saved.  You don’t need to worry about things getting “locked down” after the slate has 
been saved.  The slates can also be saved in both Windows Bitmap (BMP) and Targa 
(TGA) formats.  This lets you use the Slate Graphics that you create in other graphics 
programs.  Saving the slate as one of these graphics formats automatically saves it in the 
Page (PAG) format as well.  This keeps the slate in a format that can still be edited (Have 
you ever tried to correct the spelling of a word in a Bitmap?). 
 
All information needed to display the slate is stored in the slate file except for the 
Typefaces and the background graphic.  When a slate has a Logo or multiple Logos on it, 
the logo is stored in the slate file.  This is done to speed up the Slate Recall time.  The 
slate file does keep track of which background graphic and typefaces are used in the 
slate.  When a slate is recalled, the system will automatically load the needed typefaces 
and the background image. 
 
When a slate is saved or recalled, the dialog box first displays with the default slate 
directory.  You can select another directory to save the slate to or recall it from. 
 
The default slate directory can be changed.  See the section “Default Directories” in 
Chapter 12 for more information on how to do this. 
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Creating a New Slate 
To create a new slate, use one of the following commands: 
 
Press the “New Page” button on the Toolbar. 
Select the “New Page” entry from the “File” menu. 
Press and hold down the <Ctrl> key while pressing the <N> key. 
 
When this is done the process of creating a new slate will begin.  If the “Automatically 
Save Pages” setting in the “User Preferences” dialog box requires it, the following 
message box will appear. 
 

 
 

 
The system can only have one slate opened at a time.  When you open a new slate, the 
old slate (or any changes made to it) will be discarded unless it is saved to the disk.  If 
you want to save the changes to the old slate press <Yes>, otherwise press <No> and the 
changes will be discarded. 
 
If the slate was not saved, the following warning will appear: 
 

 
 
If you do not want to lose the changes to the current slate, press the “No” button to 
cancel the New Page operation.  You can then save the old slate. 
 
If you press the “Yes” button, all of the text and background will be erased from the 
screen.  This gives you a fresh slate to start with. 
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Opening an Existing Slate 
Opening a new slate will overwrite the slate that is currently open.  Make sure that you 
save any changes to the current slate that you want to keep before opening a new one. 
 
To open an existing slate, use one of the following commands: 
 
Select it from the listed slates in the Project Manager window. 
Select the “Open Page” entry from the “File” menu. 
Press the “Open Page” button in the Toolbar. 
Press and hold down the <Ctrl> key while pressing the <O> key. 
 
If the “Automatically Save Pages” setting in the “User Preferences” dialog box 
requires it, the following message box will appear. 
 

 
 

The system can only have one slate opened at a time.  When you open a new slate, the 
old slate (or any changes made to it) will be discarded unless it is saved to the disk.  If 
you want to save the changes to the old slate press “Yes”, otherwise press “No” and the 
changes will be discarded. 
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Once this is done the Open Page dialog box (shown below) will appear. 
 

 
Open Page dialog box 

 
Use this dialog box to select which slate to open.  Once a slate is opened it will appear in 
the “Slate Compose” window.  You can now edit the slate. 
 
Saving a Slate 
When you are finished editing a slate, you need to save it to the disk.  To do this, select 
the “Save Page” entry from the “File” menu (or press the “Save Page” button on the 
Toolbar).  If the slate already has a name, it will be saved back to the disk under the old 
name.  If the slate does not yet have a name, the Save Page As dialog box will appear 
(see Saving a Slate with a New Name) so that you can name the slate. 
 
Every once in a while, while editing a slate you should save it to disk.  This protects your 
work from things like power failures.  This function can be accomplished by holding 
down the <Ctrl> key and pressing <S>. 
 
Saving a Slate with a New Name 
To save a slate with a new slate name, select the “Save Page As” entry from the “File” 
menu.   
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When this is done, the Save Page As dialog box (shown below) will appear. 
 

 
Save Page As dialog box 

 
Use this dialog box to select a name for the slate.  The “Save as type” control allows 
you to select which format you would like to save the slate as.  This can be any of the 
following: 
 
• Page (*.PAG) 
• Windows Bitmap (*.BMP) 
• Targa format (*.TGA) 
 
Some systems may also have other formats to choose from. 
 
If you save the slate as either a Windows Bitmap or Targa format file other graphics 
programs can use the image.  Since text stored in these formats cannot be edited (without 
a great deal of difficulty), the slate will also be saved in the “Page (*.PAG)” format.  This 
keeps the slate in a format that you can edit. 
 
If the slate is saved under a new name, the old slate will remain on the disk under the old 
slate name. 
 
Deleting a Slate from the Disk 
Before you can delete a slate from the disk you must use the Open Page function to recall 
the slate to the screen.  This forces you to “look at it” to make sure it’s the right slate 
before you delete it.  Once the slate has been opened, select the “Delete Page” entry 
from the “File” menu.  A warning such as the one below will appear. 
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The second line in the warning box shows the directory and slate name of the slate about 
to be deleted.  If you don’t want to delete this slate, press the “No” Button.  Pressing the 
“Yes” button will delete the slate from the disk.  Once this is done you will not be able to 
open the slate again. 
 
Export Slate 
Many systems need to have the slates exported in a particular graphics format.  In most 
instances this is the Targa (TGA) format (although some systems require a Proprietary 
format).  The file format of the exported Slate Graphics can be set using the “User 
Preferences”. (See Chapter 15 for more information). 
 
The Slate Graphic can also be exported to the Windows Clipboard.  When a Slate 
Graphic has been exported to the clipboard, other graphic programs can used it by using 
the “Paste” function. 
 
To export a slate, press the "Export Page" button in the shortcut buttons window.  The 
slate must be named before it can be exported.  If the slate is not named, a message (like 
the one below) will appear to remind you to give the slate a name.  Once the slate is 
named, you can then export it.  The exported image will have the same name as the slate 
you are exporting (except with a different file extension).  For example: if the slate were 
export in Targa (TGA) format under the name "SLATE.PAG", the image file would be 
saved as "SLATE.TGA". 
 

 
 
If you press the “OK” button the “Save Page As” dialog box will appear to allow you 
to give the slate a name. 
 
The slate can also be exported by selecting the "Export Title Graphic" command from 
the "File" or "Project Manager" menus. 
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Templates 
 
Many users like to have a common look to their slates.  Whether it is f
facility, or a unique "look" for each client.  A Template can be created
style.  A template has "Template Fields" at different positions on the s
Template is opened, a window appears that prompts you to enter the te
Once the text is entered, the slate is automatically created using the sty
and the text that was entered in the Template Fields. 
 
Templates are controlled in two different parts of the User Interface.  T
Template Gallery and the Text Substitution Tab.  The Template Galle
open, and save Templates.  The Text Substitution Tab is used to place
to the Template Fields. 
 

Template Gallery 
The Template Gallery is on the right hand side of the User Interface w
Gallery.  The "Page Templates" tab displays all of the Templates that 
If more Templates exist than will fit in this window, you can scroll thr
the scroll bar at the bottom of the Template Gallery. 
 
Left Clicking on the Picon of one of the Templates will open the click
it can be used to create a slate.  This will display the "Enter Template 
window.  This window will be discussed later in the section titled "Cr
with a Template". 
 
Right Clicking on one of the Picons will display the Template menu sh
 

 
Page Template Menu 

 
This menu can also be displayed by selecting the "Manage Page Temp
the "File" menu. 
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New Template 
Selecting the "New Page Template" entry from the "Page Template Menu" will create a 
new Template.  When this entry is selected, the following window will appear: 
 

 
New Template Name Window 

 
Enter the name of the Template that you want to create and press the "OK" button.  Use 
the normal editing functions and the Text Substitution tab to create the Template.  
Remember to save this new slate as a Template and not as a normal slate. 
 

Edit Template 
Selecting the "Edit Page Template" entry from the "Page Template Menu" will open an 
existing Template so that you can make changes to it.  Use the normal editing functions 
and the Text Substitution tab to edit the Template.  Remember to save this slate as a 
Template and not as a normal slate. 
 
The behavior on this function is different depending on which menu it was selected from.  
If it was selected from the Main Menu, a window will appear that prompts you to select 
which Template you want to edit.  If this menu entry is selected from the popup menu 
that appears when you right click the Picon of a Template, the Template that was clicked 
on will automatically be selected as the Template to edit. 
 

Open Template 
Selecting the "Open Page Template" entry from the "Page Template Menu" will open an 
existing Template so that it can be used to create a slate.  This will display the "Enter 
Template Field Text" window.  This window will be discussed in the section titled 
"Creating a New slate with a Template". 
 
The behavior on this function is different depending on which menu it was selected from.  
If it was selected from the Main Menu, a window will appear that prompts you to select 
which Template you want to open.  If this menu entry is selected from the popup menu 
that appears when you right click the Picon of a Template, the Template that was clicked 
on will automatically be selected as the Template to open (just like left clicking on it). 
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Save Template 
Selecting the "Save Page Template" entry from the "Page Template Menu" is used to 
save the current slate or Template as a Slate Template.  When this entry is selected, the 
following window will appear: 
 

 
Save the Page Template Window 

 
If the current slate is a Slate Template, the name of the current Slate Template will 
appear in the "Page Template Name".  Enter the name that you want to save the Template 
as, and press the "Save" button. 
 

Delete Template 
Selecting the "Delete Page Template" entry from the "Page Template Menu" will delete 
the current Template.  As a safety precaution, the Template must be opened before it can 
be deleted.  Otherwise this entry will be disabled until you open the Template that you 
want to delete. 
 

Text Substitution Tab 
Once a Template has been created or opened for editing, the Text Substitution Tab can be 
used to add and change Template Fields.  The Text Substitution Tab is at the bottom of 
the User Interface along with all of the other tabs.  When the Text Substitution Tab is 
selected, it will appear as shown below: 
 

 
Text Substitution Tab 
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Substitution Variables 
Substitution variables are used to display data that may change from time to time.  These 
can be things like Temperature, Vote Counts, Sports Scores, or any other data that you 
may want to automatically update.  To enable this feature you must have an optional plug 
in that may be purchased from Cayman Graphics, Third Party Vendors, or you can write 
your own.  For more information contact Cayman Graphics. 
 
If substitution variables are enabled on your system, the controls for these will be 
displayed.  To add a variable to a slate, move the cursor to the desired position and press 
the "Add New Variable" button.  The value of the first variable in the list will appear on 
the screen and the Variable selection box will be enabled.  Select the variable that you 
want displayed at this position and its value will appear.  The variable will be displayed 
with its current value (such as current temperature) whenever this slate is displayed. 
 
Variables on a slate are treated as single characters.  When you place the cursor over a 
variable, it will appear over all of the characters in the variable and the name of the 
current variable will appear in the Variable selection box.  Any changes to the text 
attributes of a variable will be applied to all characters of the variable. 
 
Template Fields 
The controls for the Template Fields are in the box labeled "Page Template Fields".  To 
add a Template Field to a slate, move the cursor to the desired position and press the 
"Add a New Template Field" button.  When this is done the "Template Field Editor" 
window will appear as shown below. 
 

 
Template Field Editor 

 
The Template Field Name is the name that will be used when the user is prompted to 
enter the text for the Template Field.  The Default Text will appear in the  “Enter 
Template Field Text Window” when the Template is opened.  The Default Text will also 
appear in the Picon for the Template at the assigned position of the Template Field.   
 
Enter the name of the Template Field along with the Default Text for the new field and 
press the “OK” button. 
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Each Template Field is treated as a single character.  When you place the cursor over a 
Template Field, it will appear over all of the characters in the field.  Any changes to the 
text attributes of a Template Field will be applied to all characters of the field. 
 
When the cursor is placed on a Template Field the "Edit Template Field" button will be 
enabled.  Pressing this button will display the "Template Field Editor" so that the 
Template Field name and Default Text can be changed. 
 
Field and Variable Positioning 
When the text changes on a slate, the new characters may be wider or narrower than the 
Default Text.  If you position the text on the screen using the Default Text as a reference, 
the new text may no longer be lined up the same way as the old text.  On the right side of 
the "Text Substitution" tab are some buttons used to control the positioning of the new 
text.  They are all in the box labeled "After Substitution is Made:".  These buttons 
determine how the positioning should be modified after the text of the Template Field has 
been changed. 
 
This value can be set independently for each Template Field and Variable. 
 

Creating a New Slate with a Template 
When a Template is used to create a slate, (either by clicking on it in the Template 
Gallery or by selecting "Open Page Template" from the menu) a window similar to the 
following is displayed:  
 

 
Enter Template Field Text Window 

 
This window displays the name and default text of all the Template Fields that are in the 
Template.  Enter the text that you want for each Field and press the "OK" button.  The 
slate will automatically be created with the entered text.  You can now make any 
modifications to the slate before you save it as a normal slate file. 
 
Keep in mind that each Template Field will be treated as a single character until the slate 
has been saved as a normal slate, and then recalled.  After the new slate has been opened 
again, you can manipulate each character of the Template Field separately. 
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Modes, Settings, and Adjustments 

Chapter 

13
 

User Preferences 
The " Set User Preferences" dialog box is used to set preferences that may vary from 
one user to another.  To change the user preferences select the "User Preferences" 
command from the "Settings" menu.  When this is done the "Set User Preferences" 
dialog box (shown below) will appear. 
 

 
 
The set user preferences dialog box is made up of the following controls. 
 
Typeface/Logo/Texture Memory 
setting 

Used to set how much memory to use for the 
Typeface, Logos, and Textures buffer. 

Default Export Format Selects the file format of the graphic to be 
generated when the Export Page button is 
pressed  

Automatic Page Save mode Used to select the Automatic Page Save mode. 
Auto-Save Project Settings mode Used to select the Auto-Save Project Settings 

mode. 
Video Format Settings Selects the size of the Slate Graphics to be 

created. 
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Typeface/Logo/Texture Memory Setting 
When the program starts, it allocates a block of memory that is used to hold Typefaces, 
Logos, and Textures.  This memory is also used to cache data that is needed temporarily 
when composing pages.  If you allocate more memory for this, you will be able to load 
more and bigger Typefaces, Logos, and Textures.  You will also get better performance 
from the program, but less memory will be available for other applications. 
 
If you are getting an error message such as "Typeface/Logo/Texture Memory full" you 
should increase this value. 
 
Default Export Format 
The program creates a Slate Graphic whenever the Export Page button is pressed.  This 
Slate Graphic has the same name as the slate (of course the file extensions will be 
different).  This control lets you select the file format of this Slate Graphic. 
 
The Slate Graphic can also be exported to the Windows Clipboard.  When a Slate 
Graphic has been exported to the clipboard, other graphic programs using the “Paste” 
function can use it. 
 
Automatic Page Save Mode 
The program can only have one slate open at a time.  When you open a new slate, the old 
slate (or any changes made to it) will be discarded unless it is saved to disk.  When you 
open a new slate, or exit the program, the current slate can automatically be saved to disk 
if it was changed. 
 
Always Automatically Save 
This setting will automatically save the slate to disk (overwriting the original) without 
prompting you.  Use this setting with caution.  Any changes you make to the slate will be 
saved to disk.  You won’t have the option of discarding the changes that were made. 
 
Always Ask First 
This setting will ask your permission before saving the slate to disk.  If the slate has not 
been modified, you will not be asked if you want to save it.   
 
Never Automatically Save 
This setting will never automatically save the slate.  The program will not display the 
"Automatically Save Pages" window when you open a new slate. 
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Auto-Save Project Settings mode 
Various settings are saved with the Project Settings in the project file.  This file has the 
same name as the project with a .SET extension (for example, the project 
MY_PROJECT would be defined in a file called MY_PROJECT.SET).  This file 
contains the following default settings: 
 
1. Character Attributes 
2. Style Gallery 
3. Color Gradients 
4. Default Color Palette 
5. Loaded Typefaces 
6. Loaded Textures 
7. Default Directories/Folders 
8. Safetitle Margins 
9. Tab Settings 
 
When a new project is opened, or the program is exited, any changes that you have made 
to these settings will be discarded unless the project settings have been saved.  These 
controls let you select whether or not to automatically save the project settings. 
 
Always Automatically Save 
This setting will automatically save the current project settings to the project file without 
prompting you.  Use this setting with caution.  Any changes you make to the current 
settings will be saved.  You don't have the option of discarding the changes. 
 
Always Ask First 
This setting will ask your permission before saving the current project settings. 
 
Never Automatically Save 
This setting will never automatically save the project settings.  You must use the “Save 
Project Settings” entry from the “File” menu to save any changes that were made to the 
current project settings. 
 
Video Format Settings 
The values in “Video Format Settings” indicate the display resolution that the program 
is currently configured for.  Some Display Cards control the Video Format; other cards 
expect the program to determine the Video Format.  If the Display Card that you are 
using is one that controls the Video Format, a button labeled “Hardware Settings” will 
replace the “Change Video Format” button in this section.  The “Hardware Settings” 
button will be described later in this chapter.  Pressing the “Change Video Format” 
button will display the “Select Video Format” window (shown below). 
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Select Video Format Window 

 
This window lists the standard Video Formats.  If you have a High Definition (HD) 
version of the program, the “HDTV” selections will be enabled.  When a standard Video 
Format is selected, the program configures itself with the required display resolution and 
pixel aspect ratio (square or rectangular).  If none of the standard formats suit your needs, 
you can select a “Custom” format.  When this button is checked you can enter the desired 
display resolution.  The “Custom” format will create square pixels. 
 
The program must be restarted before the Video Format changes will take effect.  You 
will be reminded of this by displaying the “Video Format Changed” Window (shown 
below).  Press “Yes” to restart the program. 
 

 
Video Format Changed Window 
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Hardware Settings 
Each Display Card must have a Display Driver designed especially to interface the 
Display Card to the software.  Some of these Display Drivers are created by Cayman 
Graphics and others are created by the Display Card Manufacturers.  Each different 
Display Card has is own unique method of changing Hardware Settings.  We will discuss 
three Display Drivers that are representative of various methods use to change the 
Hardware Settings. 
 
The three Display Card drivers to be discussed will be: 

1. AJA Xena Card (SD and HD) 
2. VGA/Scan Converter 
3. Multiple VGA adapters using DirectX 

 
AJA Xena Card 
The AJA Xena card is manufactured by AJA Video (aja.com).  Both Standard Definition 
and High Definition versions of this card are available.  A system may have one of each 
installed.  These cards have Serial Digital Inputs and Outputs as well as a Sync Reference 
input (1v and 4V).  It’s Hardware Settings window appears as below: 
 

 
AJA Xena Card Hardware Settings Window. 
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The “Video Output Format” section is used to select the Video Output Format 
(obviously).  The Standard Def and Hi Def buttons are used to select which Display Card 
to use.  Only the buttons that represent the cards that are actually installed will be 
enabled.  When a card is selected, the formats that the selected card supports will be 
placed in the drop down box.  The current format will appear.  To select a different 
format, just select it from this list. 
 
Each card has two (2) Video Inputs and 1 Reference Input.  The Video format of each of 
the incoming signal is displayed in the Video Inputs Section.  The “Background Video” 
control has the following selections: 
 

1. Input 1 
2. Input 2 
3. Black 

 
Use this to select the video that you want to title over. 
 
The Reference control lists the inputs that can be used to synchronize the Video Output 
to the rest of the facility.  It has the following selections: 
 

1. Input 1 - Synchronizes to the Video Signal on Video Input 1 
2. Input 2 - Synchronizes to the Video Signal on Video Input 2 
3. Free Run - Does not synchronize to any signal. 
4. Reference (1.0 Volt) - Synchronizes to the 1 Volt signal on the Video Reference 

Input. 
5. Reference (4.0 Volt) - Synchronizes to the 4 Volt signal on the Video Reference 

Input. 
 
Video Timing controls are used to adjust the Horizontal and Video Timing of the output 
in relation to the selected Reference input. 
 
Each card can have multiple Profiles.  A Profile is a group of settings that may change 
from one configuration to the next.  You can create as many Profiles as you want.  When 
you select a profile, the settings are automatically changed to the settings that were 
assigned to the profile. 
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VGA/Scan Converter 
The program will run with just a normal VGA card.  However to get NTSC video out of 
it you will need to use either a VGA card with an NTSC output, or a scan converter that 
will convert the VGA video to NTSC video.  When using the Display Driver for the 
VGA card, the Hardware Settings window appears as below: 
 

 
VGA Card Hardware Settings Window. 

 
This window shows where the Video output will be displayed on the output.  It can be 
size and positioned using this window.  If you have multiple Video screens, you can even 
move it to one of the other ones.  Normally this should cover the entire screen, but in 
some cases you may want to have the Video Output appear at a certain position on the 
screen.  Beware, that when you are displaying slates, this will cover your User Interface 
if it is on the main screen. 
 
This window can be moved by dragging the Title Bar around the screen or by changing 
the” Top” and “Left” values.  Dragging the edges of the windows will change the size of 
the window.  Changing the “Width” and “Height” values can also change the window 
size.  The Window can be size to full screen by checking the “Maximize Window” 
button. 
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Multiple VGA adapters using DirectX 
If you have multiple VGA screens, and DirectX version 6.0 or later installed on your 
system, you will probably get better performance using this Display Driver than the 
VGA/Scan Converter Driver.  However to get NTSC video out of it you will need to use 
either a VGA card with an NTSC output, or a scan converter that will convert the VGA 
video to NTSC video.  When using the Display Driver for the Multiple VGA cards, the 
Hardware Settings window appears as below: 
 
 

 
Multiple VGA Card (DirectX) Hardware Settings Window. 

 
The “Display Devices” drop down box lists all of the DirectX compatible Display 
Adapters that are installed on your system.  You main VGA screen has two listings in the 
drop down box.  The “Primary Display Driver” and the actual name of the card that is 
used by the Primary Display.  If you use either one of these as your Display Device, it 
will cover your user interface while you are displaying slates. 
 
Once the Display Device is selected, the “Display Modes” list displays the Display 
Modes that are available with the selected Display Device.  Select the Display mode that 
you want and press OK.  The program will then adapt itself to the new settings. 
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Setting up Tabs 
The program can set up to 16 tabs per slate.  The tabs specify horizontal positions of the 
screen that are used to align columnar text.  The tab positions are stored with the slate.  
When a slate is opened, the tab positions will be set to those that the slate was created 
with. 
 
To add, remove, or reposition a tab, or to enable or disable the tab display, select the "Set 
Up Tabs" command from the "Settings" menu.  This will display the “Set Up Tabs” 
dialog box (shown below). 
 

 
 
Display Tab Positions 
The Tab Display shows the positions of the tabs that are currently set.  If the tab display 
is enabled, vertical lines will appear the full height of the screen.  Each one of these 
vertical lines shows the position of a tab that is currently set.  Clicking the "Display Tab 
Positions" check box will toggle the state of the Tab Display.  If the Tab Display is on 
(signified by a check mark), this will turn it off. 
 
Markers in the set up tabs window  (below the slate compose window) also shows the 
current tab positions.  These markers are displayed regardless of the "Display Tab 
Positions" setting.  Let's call this window the "Tab Markers Window". 
 
Once the tabs have been set up, they can be saved as the default tab settings in a project. 
 
Set a New Tab 
The Tab Markers window displays all of the tabs that are currently set.  To set a new tab, 
position the mouse in the Tab Markers window at the position that you want the new tab 
and click the left mouse button.  A new marker will appear at the mouse position to 
indicate the position of the new tab. 
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Move a Tab 
To move (reposition) an existing tab, position the mouse over the Marker that you want 
to move and drag it to the desired position.  Any text that is on the slate will be redrawn 
to reflect the new tab position. 
 
Delete a Tab 
To delete an existing tab, select the marker that you want to delete by moving the mouse 
over it and pressing the left mouse button.  The marker will turn red to indicate that it is 
selected.  Press the "Delete Tab" button.  The selected marker will be deleted. 
 

Safetitle Margins 
When transmitting a video signal to a large number of televisions, many of those 
televisions will not be properly adjusted.  If you create a full slate of text and try to view 
it on one of these televisions, the text may be cut off on the left, right, top, or bottom of 
the screen.  When you broadcast text, you normally want everyone to be able to read it 
(especially if you are trying to sell them a new TV). 
 
To solve this problem we define margins that it is safe to title within.  The margins are 
set by the factory to be at the recommended 10% height and width positions of the 
screen.  You can change these margin positions.  To do this select the "Safetitle 
Margins" command from the "Settings" menu.  When this is done the Safetitle margins 
dialog box (shown below) will appear.   
 

 
 
Use the "Display Safetitle Margins" check box to hide or display the Safetitle margins 
on the screen.  The Safetitle margins are displayed on the screen whenever the "Safetitle 
Margins" window is displayed, regardless of the state of the "Display Safetitle 
Margins" check box. 
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If you keep your text within this box it will be in the Safetitle area.  Use the arrow 
buttons to move the Safetitle margins.  Each margin (top, bottom, left, and right) has two 
buttons that are used to move them. 

 
 
Moves the margin up one scanline. 

 
Moves the margin left one pixel. 

 
 
Moves the margin down one scanline. 

 
Moves the margin right one pixel. 

 
You can also set the margin positions by entering a value directly. 
 
To set the margins to the recommended 10 percent height and width positions of the 
screen, press the "Default" button. 
 
Once the Safetitle margins are adjusted, press the “Done” button.  This will remove the 
dialog box from screen.  The Safetitle settings are saved as one of the project settings. 
 

Lower Third Mode 
While titling an image, you will quite often want to keep the slates in the Lower Third 
position of the screen.  To do this, without needing to re-position every slate, set the 
system to Lower Third mode.  This moves the top margin (as well as the slate text) to the 
Lower Third position.  Any slates composed in this mode will appear in the Lower Third 
portion of the screen.  Centering a slate in this mode will center it in the Lower Third 
area. 
 
To change the Lower Third mode select the "Lower Third Mode" command from the 
"Settings" menu.  If the system is already in Lower Third mode, the Lower Third mode 
will be turned off.  You can also toggle the Lower Third mode by holding down the 
<Ctrl> key while pressing the <T> key.   
 
The current lower third mode can be saved as one of the default project settings. 
 

Default Directories 
The program allows you to put any file in any directory on any disk.  This often results in 
files that you can never find again.  It is best to keep files of the same type (or the same 
project) in the same directory.  Default directories are a big help here.  The system allows 
you to set default directories for the different file types.  The default directories, and the 
type of files that default to these directories, are shown below. 
 
Page Directory 
The slates for the current project. 
 
Exported Graphics 
Graphic images that are exported when you press the "Export Page" button. 
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Imported Graphics 
Where the program will look for Background Images if they are not found in their 
original location. 
 
Typeface Directory 
Typefaces 
 
Page Templates 
Where the Templates should be stored.  They will only appear in the Template Gallery if 
they are stored in this directory. 
 
Temporary 
This is the directory that the program will use for any temporary files that it needs to 
create. 
 
To change the default directories, select the "Default Directories" command from the 
"Settings” menu.  When this is done the “Default Directories” Dialog box (shown 
below) will appear. 
 

 
 
This dialog box displays the default directories and their current settings.  The path can 
be entered directly, or you can browse for the desired directory. 
 
To enter a path directly, select the default directory entry that you want to change, and 
type in the full drive and path.  This should be in a form such as C:\PATH.  When you 
directly enter a default directory, you must make sure that the path exists on the specified 
drive. 
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To browse for the desired directory, press the "Browse" button next to the directory that 
you want to change.  When this is done the “Select Directory” dialog box (shown 
below) will appear. 
 

 
 
Use this dialog box to select the new default directory.  The controls in this dialog box do 
the following: 
 
Directories List 
Use this control to select the default directory. 
 
Drives 
Selects the drive that contains the desired default directory. 
 
OK button 
Press this button when the directory is selected. 
 
Cancel button 
Press this button to cancel the directory selection. 
 
When you are done selecting the default directories, press the "OK" button in the default 
directories dialog box.  If you want to cancel the changes you have made, press the 
"Cancel" button. 
 
Once the new default directories are selected they must be saved as part of the project 
settings.  Otherwise, they will revert to the old settings when the project is opened again. 
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Modifying the Color Palette 
To modify the color palette, the color palette must be displayed.  You can display the 
color palette by selecting the "Colors" tab in the Control Tabs Window and then pressing 
the "Palette" button.  Position the mouse over the color palette entry that you want to 
change and double-click it with the left mouse button.  When this is done the "Color 
Palette Editor" window (shown below) will be displayed. 
 

 
 
The color palette editor has two methods of selecting a color.  You can use either the 
Color Picker or the Color Sliders.  The left side of this window shows a large sample of 
the current color selection.  To the right of the color sample, at the bottom of the window, 
is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, 
this indicator will appear red to indicate that you have selected an illegal color.  
Otherwise this indicator will appear green. 
 
At the top of the screen, between the Color Sample and the Color Palette, are the 
Color Picker controls.  These controls include a "Hue Picker" and a "Color Picker 
Area".  The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color.  Place 
the mouse over this control, and press the left mouse button to select the desired hue.  
When the new hue is selected, the Color Sample, Color Picker Area, and the Color 
Sliders will be updated to reflect the new hue. 
 
Once the hue is selected you can now pick the color.  Place the mouse over the Color 
Picker Area and press the left mouse button.  This will select the color under the mouse.  
If you hold down the left mouse button while the mouse is moved, the Color Sample 
and the Color Sliders will be updated to reflect the newly selected color. 
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Below the Color Picker Controls and the Color Palette Display are the Color Sliders.  
There are two numerical systems for defining colors.  These are RGB (Red, Green, Blue), 
and HLS (Hue, Luminance, Saturation).  Both of these systems are used to define the 
same thing (like yards and meters).  You can use either set of sliders to adjust the color.  
Changing one will automatically change the other. 
 
There are four ways to adjust the RGB, HLS, Transparency, and Background Video 
levels.  They can be adjusted by dragging the sliders.  Double-clicking the number box 
and entering the new value with the keyboard can also adjust them.  To "fine tune" the 
levels, use the increment and decrement buttons.  The value will be increased or 
decreased by one each time you press one of these buttons.  These buttons will auto-
repeat if you hold them down.  Clicking in the number box and dragging the mouse will 
also change the values. 
 
To the right of the Illegal Color Indicator is a "Transparent" button.  Pressing this 
button will set the transparency level to full (255).  This makes the color fully 
transparent.  Anything that you assign this color to will not be visible. 
 
To the right of the "Transparent" button is a "Background Video" button.  Pressing 
this button will set the background video level to full (255).  Anything that you assign 
this color to will be displayed using background video. 
 
To the right of the "Background Video" button is a "Pick Color From Screen" button.  
Pressing this button will change the mouse cursor to look like an eyedropper.  Move the 
mouse to the position of the screen that you want to copy the color of, and press the left 
mouse button.  The color under the mouse will be selected. 
 
When you have selected the desired color for the color palette entry, you can select 
another color to modify from the color palette.  When you are done modifying the color 
palette, press the "OK" button and the Color Palette Editor window will close.   
 
Once the color palette has been modified, the changes must be saved as part of the project 
settings.  Otherwise, they will revert to the old settings when the project is opened again. 
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Loading Textures 
The system has 16 slots that textures can be loaded into.  When you use a texture on a 
slate, the slate keeps track of which textures are needed to display the slate.  If the 
textures that are loaded do not match the textures needed by the slate, the correct textures 
will be automatically loaded. 
 
To load a new texture, the texture selection window must be displayed.  You can display 
the textures selection window by selecting the "Colors" tabs from the Control Tabs 
Window and then pressing the "Textures" button.  Position the mouse over the texture 
entry that you want to replace with the new texture and double-click it with the left 
mouse button.  When this is done the "Select Graphic Image to use as a Texture" 
window (shown below) will be displayed. 
 

 
 
Select the graphic image that you want to load as a texture and press the "Open" button.  
The selected image will then be loaded as a texture. 
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Building Color Gradients 
64 color gradients can be defined for each project.  To modify a color gradient, the color 
gradient selection window must be displayed.  You can display the color gradient 
selection window by selecting the "Colors" tab from the Control Tabs Window and then 
pressing the "Gradient" button.  Position the mouse over the gradient that you want to 
modify and double-click it with the left mouse button.  When this is done the color 
gradient builder (shown below) will be displayed. 
 

 
 
The color gradient builder has two major sections, the Color Selection section (on the 
right) and the Color Point Placement and Selection section (on the left).  The Color 
Selection section is used to select the color of each point in the color gradient.  The Color 
Point Placement and Selection section is used to select which point that you want to 
change the color of, and to change the position of the color points that make up the 
Gradient. 
 
The program can create two types of color gradients, Linear Gradients and Area 
Gradients.  A Linear Gradient can have as many as 16 color points and can be rotated up 
to 90 degrees in either direction.  An Area Gradient can have either four (4) or five (5) 
color points.  A four-point color gradient lets you define a different color in each corner 
of the rectangle.  A five-point color gradient also lets you add a 5th color point inside the 
Area Gradient.  The 5th color point can be moved to any position inside the gradient. 
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The color point placement and selection section has two tabs.  One tab is used to edit 
Area Gradients and the other tab is used to edit Linear Gradients.  When the color 
gradient builder is first opened, the tab that corresponds to the type of gradient that you 
are editing is selected.  To change the color gradient to the other type just select the other 
tab. 
 
Area Gradients 
The “Area Gradient” tab (shown below) is used to edit area color gradients. 
 

 
 
The top portion of this window displays the current color gradient.  If it is a five-point 
color gradient, two markers will appear.  One marker above the gradient and one to the 
left of the gradient.  These indicate the position of the fifth point inside the gradient.  You 
can move the inside color point by dragging these markers.  You can also moved the 
inside color point by clicking at the desired position in the color gradient in this window. 
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The Corners group is used to select the color point(s) of the Area Gradient that you want 
to change the colors of.  If the color gradient is a 4 Point Area Gradient, four check boxes 
will be displayed representing each corner of the gradient.  If the color gradient is a five 
point Area Gradient, an extra check box will appear which represents the inside color 
point.  When a color point is selected, the box is marked.  You can select more than one 
color point to be changed at a time.  When you select a different color (in the color 
selection section) all of the selected points will be updated to the new color.   
 
There are two buttons in the Spread Type Group that let you select whether this will be a 
4 Point or a 5 Point color gradient.  If you select " 5 point", the positioning markers will 
appear.  A center check box in the corners group will also appear. 
 
The "Apply Color to Selected Corners" button will set all of the selected color points 
to the current color. 
 
Linear Gradients 
The Linear Gradient tab (shown below) is used to edit Linear Color Gradients. 
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The Linear Gradient tab has three main controls.  The control on the left (let’s call it the 
Placement Control) displays the current position and color of each point on the Linear 
Gradient.  The top control displays the current Linear Color Gradient.  The bottom 
control (let’s call it the Angle Control) is used to set the angle of the Linear Color 
Gradient. 
 
The Placement Control shows positions and colors of the color points that are currently 
set.  A marker on the left side of the Placement Control represents each color point.  You 
can use this control to add a new color point, move an existing color point, delete a color 
point, or to select a color point to change the color of.   
 
Set a New Color Point 
To set a new color point, position the mouse over the Placement Control where you want 
the new color point to be and press the left mouse button.  A new marker will appear at 
the mouse position to indicate the new color point. 
 
Move a Color Point 
To move (reposition) an existing color point, position the mouse over the marker that you 
want to move and drag it to the desired position. 
 
Delete a Color Point 
To delete an existing color point, select the marker that you want to delete by moving the 
mouse over it and pressing the left mouse button.  The marker will turn red to indicate 
that it is selected; all other non-selected markers will be blue.  Press the <Del> key on the 
keyboard, and the selected marker (and color point) will be deleted. 
 
Change the Color of a Color Point 
To change the color of a color point, select the color point that you want to change the 
color of, by moving the mouse over its’ marker and pressing the left mouse button.  The 
marker will turn red to indicate that it is selected.  Use the controls in the Color Selection 
section (on the right hand side) of the Color Gradient Builder. 
 
Rotating a Linear Gradient 
Use the angle control to rotate the Linear Gradient.  The angle control indicates the 
current rotation angle of the gradient with the line that is in the half circle.  If the gradient 
is vertical, the indicator line in the half circle will be vertical.  If the gradient is angled to 
the right, the indicator line will go off to the right, and so on.  You can rotate the Linear 
Gradient by clicking the mouse within the half circle.  You can also drag the rotation 
angle by dragging the indicator line back and forth.  As the rotation is changed the color 
Gradient Indicator (above the angle control) is redrawn to display the new angle of 
rotation. 
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Selecting a Color for the Color Point 
Once you have selected which point(s) that you want to change the color of, use the 
Color Selection controls (on the right hand side of the Color Gradient Builder) to select 
the new color.  The Color Gradient Builder has three methods of selecting a color.  You 
can use either the Color Picker, the Color Sliders, or the Color Palette.   
 
At the top of the screen, on the left-hand side of the color selection section, are the Color 
Picker controls.  These controls include a "Hue Picker" and a "Color Picker Area".  
The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color.  Place the 
mouse over this control, and press the left mouse button to select the desired hue.  When 
the new hue is selected, the Color Gradient, Color Picker Area, and Color Sliders will be 
updated to reflect the new hue. 
 
Once the hue is selected, you can now pick the color.  Place the mouse over the Color 
Picker Area and press the left mouse button.  This will select the color under the mouse.  
The Color Gradient and the Color Sliders will be updated to reflect the newly selected 
color.  If you hold down the left mouse button while the mouse is moved, the color under 
the mouse will be selected as the mouse is moved. 
 
To the right of the Color Picker controls is the Color Palette.  The Color Palette has 64 
preset colors.  Not all of the preset colors can be displayed at one time, so there is a scroll 
bar on the right hand side of the Color Palette.  Use the scroll bar to scroll through all of 
the preset colors.  To select a color from the Preset Color Palette, left click the desired 
color.  When a color is selected from the color palette, the Color Gradient, Color Picker 
Area, and the Color Sliders will be updated to reflect the new color. 
 
Below the Color Picker controls and the Color Palette display are the Color Sliders.  
There are two numerical systems for defining colors.  They are RGB (Red, Green, Blue) 
and HLS (Hue, Luminance, Saturation).  Both of the systems are used to define the same 
thing (like yards and meters).  You can use either set of sliders to adjust the color.  
Adjusting one will automatically change the other. 
 
There are four ways to adjust the RGB, HLS, Transparency, and Background Video 
levels.  They can be adjusted by dragging sliders.  Double-clicking the number box and 
entering the new value with the keyboard will also adjust them.  To "fine-tune" the levels, 
use the increment and decrement buttons.  The value will be increased or decreased by 
one each time you press one of these buttons.  These buttons will auto-repeat if you hold 
them down.  Clicking on the number box and dragging the mouse will also change the 
values. 
 
This section includes an Illegal Color Indicator to warn you if the selected color exceeds 
NTSC or PAL limitations.  The Illegal Color Indicator will appear red if you have 
selected an illegal color, otherwise it will appear green. 
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To the right of the Illegal Color Indicator is a "Transparent" button.  Pressing this 
button will set the transparency level to full (255).  This makes the color fully 
transparent.  This portion of the color gradient will not be visible.  You will see what is 
behind it on screen. 
 
To the right of the "Transparent" button is a "Background Video" button.  Pressing 
this button will set the Background Video level to full (255).  This portion of the color 
gradient will be displayed using Background Video. 
 
To the right of the "Background Video" button is a "Pick Color From Screen" button.  
Pressing this button will change the mouse cursor to look like an eyedropper.  Move the 
mouse to the position of the screen that you want to copy the color of, and press the left 
mouse button.  The color under the mouse will be selected. 
 
Once you have finished changing the color of the selected color point(s), you can select 
another color point to change the color of. 
 
Final steps 
When you are finished creating the new Color Gradient (or modifying an existing 
gradient) press the "OK" button and the Color Gradient Builder window will close.  Any 
changes to the color gradients must be saved as part of the project settings.  Otherwise 
they will revert to the old Color Gradients when the project is opened again. 
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Exiting the Slate Genera
 

Well, all good things must come to an end.  This is also true of manua
Manuals just sort of fade into the back cover.  But programs need to b
 
When it’s time to exit the Slate Generator, select the “Exit” command
menu.  The program will begin its shut down sequence.  The program 
by holding down the <Alt> key while pressing <X>. 
 
Any slate changes or settings changes that are not saved will be lost w
program. 
 
If the slate has been modified, and the “Automatically Save Pages” se
Preferences” dialog box requires it, the following message will appear
 

 
 

If you want to save the changes to the slate, press the <Yes> button.  O
<No> button and the changes will be discarded. 
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If the “Auto Save Project” setting mode is set to “Always ask First”, the program will 
display the following message box just before the program exits. 
 

 
 
This message box gives you the option of saving the current project settings before you 
exit. 
 
The current project settings include the following: 
 
1. Character, Edge, and Shadow attributes. 
2. Style Gallery 
3. Color Palette Settings. 
4. Color Gradients 
5. Loaded Typefaces 
6. Loaded Textures 
7. Typing mode 
8. Lower Third mode 
9. Default Directories 
10. Any changes that you made to the Safetitle Margins, and Tab Settings. 
 
Press <Yes> to save the project settings and exit the program.  If you save the settings 
they will be restored the next time you open the project.  Press <No> to exit the program 
without saving the settings. 
 
We hope you have enjoyed using the Slate Generator. 
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